TaskMerlin User’s Guide

Personal and Professional Editions, v. 5.0
## Version History

<table>
<thead>
<tr>
<th>Date</th>
<th>Document Version</th>
<th>Software Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>August, 2011</td>
<td>1.0</td>
<td>TaskMerlin Personal and Professional Editions, 4.0</td>
</tr>
<tr>
<td>February, 2013</td>
<td>2.0</td>
<td>TaskMerlin Personal and Professional Editions, 5.0</td>
</tr>
</tbody>
</table>

Copyright © 2011 Interfathom, LLC. All rights reserved.
Printing Folders and Item Details .........................................................145
A Project Manager’s Guide to Reporting and Printing .......................146

CHAPTER 9: MANAGING USERS AND USER PERMISSIONS ..............148
Collaborating with Coworkers ............................................................148
Managing Users (Personal and Professional Editions) .......................148
   Adding Users .................................................................................149
   Replicating Users’ Configurations ..............................................152
   Viewing and Changing Users’ Account Information ..................155
   Deleting User Accounts ............................................................158
Managing Permission Templates (Professional Edition Only) ..........160
   About the Default Permission Templates ..................................160
   Template vs. User Level Permissions ........................................161
   Customizing Existing Permission Templates .............................161
   Creating Permission Templates .................................................167
   Deleting Permission Templates ................................................168
Setting Up Users’ E-mail Options ....................................................170
   Setting Database E-mail Options ..............................................170
   Setting Up Users’ E-mail ..........................................................173
A Project Manager’s Guide to Managing Users and Permissions ....176

CHAPTER 10: MANAGING YOUR DATABASES ..................................178
About Databases .............................................................................178
The Default Database .....................................................................178
Creating a Database ......................................................................178
   Creating a Blank Database .......................................................179
   Creating a Database from an Existing Database ......................180
Navigating Between Databases ......................................................180
Customizing Databases ...............................................................181
   Getting Information About a Database ...................................181
   Adding a Descriptive Name and Setting Database Properties ...182
Exporting and Importing Database Settings ....................................184
   Exporting Database Settings ....................................................184
   Importing Database Settings ....................................................186
Backing Up the Database .............................................................188
Compacting the Database ............................................................189
A Project Manager’s Guide to Managing Databases .......................190
ONE USER’S EXPERIENCE

As a technical writer for a company in the finance industry, I first became acquainted with TaskMerlin after a year-long search for a task-management tool that would help me manage the 100 documents I write each year. Having tried several packages, I despaired of ever finding software that was both structured enough to help me corral my workload into tasks and projects and yet flexible enough to let me customize components of my projects when I needed to.

Enter TaskMerlin. One day, after yet another Internet search for “task management software,” I came across TaskMerlin. The Interfathom Web site was professionally done, the price fit my budget, and I could download a trial version, which I did that day.

One week later I had bonded with my new tool. I had set up my projects and tasks in an hour, and I was already learning how to customize TaskMerlin’s features to suit my busy schedule and deadlines.

I've documented dozens of software packages in my 15-year career, so I'm picky about the software I use myself. Having used TaskMerlin daily for the last two years, I can testify to the fact that TaskMerlin is unlike any task-management tool on the market. In fact, it's not just a task-management tool; it's a project-management tool, too. Designed for one, several, or many users, and functional on both a personal computer and across a network of computers, TaskMerlin is the go-to tool for managing projects when other project management tools would be overkill. I’m happy to introduce you to this product.

Let's get started!

Karen Field Carroll

Karen Field Carroll
Sr. Technical Writer and Author
CHAPTER 1: GETTING STARTED

TaskMerlin is designed to help you manage both tasks and projects. Using TaskMerlin, you can create project files and add tasks to them. You can track those projects using the Calendar (Personal and Professional Editions) and the Gantt Chart (Professional Edition only).

But you can also create items that represent other aspects of a project, such as its meetings (and meeting notes), its reference files (such as functional specifications), and even the people who work on that project. You can even import project documents into TaskMerlin or link an item to them from TaskMerlin.

TaskMerlin Personal Edition

The TaskMerlin Personal Edition is designed for users who work on their projects alone and who do not need to collaborate on projects with other users across a network or the Internet.

TaskMerlin Professional Edition

The TaskMerlin Professional Edition is designed for users who must share TaskMerlin project files across a network or the Internet. TaskMerlin Professional Edition includes the Gantt Chart.

Using this Guide

This User's Guide explains how to use both the Personal and Professional Editions. In addition to explaining how to use TaskMerlin, each chapter includes a section called “A Project Manager’s Guide,” which explains how to apply what you learn in the chapter to project management.

Read these sections to find out more.

- "Where to Begin," this page
- "Getting Around Your Projects" on p. 9
- "Managing Items in your Projects" on p. 9
- "Scheduling Appointments and Project Information" on p. 9
- "Tracking Project Tasks and Deadlines" on p. 9
- "Adding Documents to Your Projects" on p. 9
- "Reporting and Printing Project Information" on p. 9
- "Working with Other Users" on p. 9
- "Backing Up Your Project Files" on p. 9

Where to Begin

If you’re already familiar with TaskMerlin, you can skip the chapters you don’t need and go to the ones about features you want to explore. If, however, you’re new to TaskMerlin, we recommend reading the guide starting with Chapter 1, which provides an overview of the TaskMerlin workspace.
## Getting Started

### Getting Around Your Projects
Once you’ve set up your projects, "Navigating the TaskMerlin Workspace" on p. 30 explains how to find items and import and export them between external files and even other TaskMerlin databases.

### Managing Items in your Projects
Items represent various parts of a project, such as tasks, people, or information. "Working with Items and Item Types" on p. 60 explains how to create and edit items in your projects.

### Scheduling Appointments and Project Information
"Using the Calendar" on p. 96 explains how to schedule your tasks on the Calendar, track them, and update the Calendar as your schedule changes. An item’s dates, such as Start date and Deadline, appear on both the Calendar and the Gantt Chart.

### Tracking Project Tasks and Deadlines
"Using the Gantt Chart" on p. 114 explains how to track your projects’ progress in the Gantt Chart. Gantt Charts are available in TaskMerlin Professional Edition only.

### Adding Documents to Your Projects
A key part of any project is its reference information. Often this information resides in Word® or Excel® documents outside of your TaskMerlin files. You can either link or import (embed) these files in TaskMerlin to keep all the information about a project in one place. "Managing Project Documents" on p. 122 explains how.

### Reporting and Printing Project Information
When project stakeholders need a status about the project, or if you want to create a snapshot of a project at any point in it, you can use the reporting and printing features to handle these tasks. "Reporting and Printing" on p. 140 shows you how.

### Working with Other Users
If you share the Personal Edition of TaskMerlin with other users, "Managing Users and User Permissions" on p. 148 can get you started on setting up basic user permissions, including e-mail.

If you’re using the Professional Edition, we recommend reading this chapter completely to understand the more robust features that apply to managing users in the Professional Edition.

### Backing Up Your Project Files
Any project manager knows how important it is to back up a project’s files. This User Guide concludes with a chapter on backing up and maintaining your TaskMerlin databases. See "Managing Your Databases" on p. 178 for this information.
CHAPTER 2: SETTING UP THE TASKMERLIN WORKSPACE

Use this chapter to become familiar with the TaskMerlin workspace and then to tailor it to your needs.

This chapter covers the following topics:
- "The TaskMerlin Workspace," this page
- "Tailoring the Workspace Using the Setup Wizard" on p. 17
- "Organizing the Workspace by Task or Notes Views" on p. 20
- "Tailoring the Edit Item Window" on p. 21
- "A Project Manager's Guide to Setting Up the Workspace" on p. 28

The TaskMerlin Workspace

The TaskMerlin workspace is the primary window in TaskMerlin. It captures the structure, status and schedule for each of your projects.

The TaskMerlin workspace is what you see the first time you launch TaskMerlin. (Later you can tailor how the workspace appears in your version of TaskMerlin.) Figure 1 shows the TaskMerlin workspace as it appears when you install and launch TaskMerlin for the first time.

The workspace includes these work areas, or panes, which this section describes:
- Folders list (p. 11)
- Item Grid (p. 12)
- Edit Item window (p. 12)
- Filters list (p. 14)
- Preview and Preview Details panes (p. 14)
- Calendar (p. 15)
- Gantt Chart (Professional Edition only) (p. 16)
- Month View tab (p. 16)
This image shows each of these areas.

The Folders List

A folder is any item that can contain other items. Certain items are folders by default. Others you can make folders when you create them.

By default, the Folders list shows any items you designate as folders when you create them. (Later you’ll see how you can view even non-folder items in the Folders list.)

The Folders list is a quick way to see the overall structure of your project files.
The image points out the Folders list.

Figure 2: Folders list

Using the Folders list to navigate project items is covered in "Navigating the TaskMerlin Workspace" on p. 30.

The Item Grid

The Item Grid shows the items for the folder selected in the Folders list. For example, if you click the Folder called Office, you see the Office folder's items in the Item Grid.

The Item Grid provides a lot of information about an item, such as its type (Project or Task, for example), a summary of the item, the item's status (Not Started, In Progress, and so on), and its priority (Highest, High, Medium, and so on). You can customize the Item Grid to show you only the information you want to see about an item. That's explained in "Navigating the TaskMerlin Workspace" on p. 30.
This image shows the Item Grid. This particular grid includes items in the Corporate Web Site folder.

Using the Item Grid to navigate items is covered in "Navigating the TaskMerlin Workspace" on p. 30.

The Edit Item window is where you capture information about each project and task, such as start date, priority, or status. You can change the fields and tabs on the Edit Item window once you figure out how TaskMerlin works best for you.

This image shows the Edit Item window. For instructions on tailoring it to your needs, see "Tailoring the Edit Item Window" on p. 21.

Figure 3: Item Grid

Figure 4: Edit Item window
Preview and Preview Details Panes

The Preview and Preview Details panes show the attributes, or specifics, of any item you select in the Item Grid. While the Item Grid provides summary information about items, the Preview pane shows the details of a selected item. It's a quick way to see the item's details without opening it in a separate window.

You can tailor the fields in the Preview pane, too. See "Preview and Preview Details Panes" on p. 14 for instructions.

This image shows the Preview and Preview Details panes.

Using the Preview pane to manage items is covered in "Navigating Items Using the Item Grid" on p. 45.

Filters List

Filters help you see items in groups. If you have 50 items in the Item Grid, for example, you can use a filter to narrow that list to only items with certain traits.

You can also set up filters to filter items within one folder.
This image shows the Filters list.

Figure 6: Filters list

Creating and using Filters is covered in "Navigating Items Using Filters" on p. 33.

The Calendar pane is where you can track your schedule and manage appointments. You can schedule any type of item so that it appears on the Calendar. Then you can determine how much information about the item appears in the Calendar itself.

This image shows the Calendar with a view of three days. However, you can see from one day to one month in the Calendar pane.

Figure 7: Calendar pane
Scheduling items on the Calendar is discussed in "Using the Calendar" on p. 96.

**Gantt Chart**

A Gantt Chart is a bar graph showing the timeline for a project's tasks and events. The TaskMerlin Professional Edition includes the Gantt Chart.

This image shows the Gantt Chart. For more about using it, see "Using the Gantt Chart" on p. 114.

**Month View Tab**

The Month View tab (behind the Filters list) is a convenient place to select how many days you want to see in the Calendar pane or the Gantt Chart. This image shows the Month View tab.
Using the Month View tab to navigate the Calendar is covered in "Using the Calendar" on p. 96.

**Tailoring the Workspace Using the Setup Wizard**

You can tailor the fields and panes you see in the TaskMerlin workspace using the Setup Wizard. The Setup Wizard opens the first time you use TaskMerlin, but you can also open the Setup Wizard to change your workspace once you’ve used TaskMerlin.

The options you choose in the Setup Wizard affect what you see in the Item Grid pane, the Preview Details pane, and the Edit Item window. (You can later tailor these even further, though.)

To tailor your workspace, take these steps:

1. To open the Setup Wizard, click the **Setup Wizard** button on the tool bar.

2. In the Setup Wizard, click **Next**.

---

**Note** You can change your login ID name or password here, too. Click the More user settings button to get started.
3. In the window that opens, choose the fields you want, using the following table as a guide.

In this window, you select fields to use in the Item Grid, Edit Item window, and Preview Details panes. (But you can also change these fields in the workspace itself later. See "Navigating the TaskMerlin Workspace" on p. 30.)

<table>
<thead>
<tr>
<th>If you use TaskMerlin to</th>
<th>Click</th>
<th>So the workspace includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep the same fields you have now</td>
<td>It's set up how I like it now</td>
<td>The same fields you've been using</td>
</tr>
<tr>
<td>Manage your own tasks and to-do lists</td>
<td>Task lists (to-do lists, GTD, Agile)</td>
<td>A simple layout with few date and advanced fields</td>
</tr>
<tr>
<td>Manage projects</td>
<td>Project planning (Gantt Chart)</td>
<td>A comprehensive layout with date fields and many advanced fields</td>
</tr>
<tr>
<td>Manage appointments</td>
<td>More options, and then Appointments and events (calendar)</td>
<td>A comprehensive layout with date fields and some advanced fields</td>
</tr>
<tr>
<td>Use the same layout you did in Version 4</td>
<td>More options, and then Classic (version 4 layout)</td>
<td>The same layout you saw in Version 4</td>
</tr>
<tr>
<td>Keep track of documents and images</td>
<td>More options, and then Information (word processing, links, images)</td>
<td>A simple layout with few date and advanced fields</td>
</tr>
<tr>
<td>Keep track of many things</td>
<td>More options, and then Include everything I might need</td>
<td>A fully comprehensive layout</td>
</tr>
<tr>
<td>Track basic information</td>
<td>More options, and then Simplify as much as possible</td>
<td>A minimalist layout</td>
</tr>
</tbody>
</table>

As you select these options, you can see the changes in the workspace. This image shows these options.

Figure 12: Setup Wizard: Choosing layout
4. Click **Next**. The next Setup Wizard window opens.

![Setup Wizard: Choosing panes](image)

**Figure 13: Setup Wizard: Choosing panes**

In this window, choose the panes for your workspace. Use this table as a guide.

<table>
<thead>
<tr>
<th>Click</th>
<th>To see</th>
<th>So the workspace includes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Folders</strong></td>
<td>The Folders pane</td>
<td>The Folders list&lt;br&gt;To see items not marked as folders in the Folders list, click the Also show the non-folder items check box.</td>
</tr>
<tr>
<td><strong>Item Grid</strong></td>
<td>The Item Grid</td>
<td>A list of your items</td>
</tr>
<tr>
<td><strong>Item Filters</strong></td>
<td>The Filters pane</td>
<td>The list of filters</td>
</tr>
<tr>
<td><strong>Item Content</strong></td>
<td>The Item Contents pane</td>
<td>The selected item's content beneath the Item Grid&lt;br&gt;To include the Preview Details pane, click the Also show the item fields check box.</td>
</tr>
<tr>
<td><strong>Calendar</strong></td>
<td>The Calendar pane</td>
<td>The Calendar showing items with dates&lt;br&gt;To see the Date Selector tab, click Also show the date selector.</td>
</tr>
<tr>
<td><strong>Gantt Chart</strong></td>
<td>The Gantt Chart pane</td>
<td>The Gantt Chart showing items with dates</td>
</tr>
</tbody>
</table>
As you choose the panes in the Setup Wizard, those panes open in workspace behind it.

![Figure 14: Setup Wizard, Choosing panes](image)

5. Click **Finished**.

The workspace now has your new fields and panes.

**Organizing the Workspace by Task or Notes Views**

You can change the workspace to one of the options in this table.

<table>
<thead>
<tr>
<th>This view</th>
<th>Shows these panes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task View</td>
<td>Folders list, Item Grid, Gantt Chart, and Preview Pane</td>
</tr>
<tr>
<td>Task View with Filters</td>
<td>Folders list, Item Grid, Gantt Chart, Preview Pane, and Filters list</td>
</tr>
<tr>
<td>Task View with Calendar</td>
<td>Folders list, Item Grid, Calendar, Gantt Chart, Preview Pane, and Month View list</td>
</tr>
<tr>
<td>Notes View</td>
<td>Folders list with tasks, Content and Preview Details panes of the selected item in the Folders list</td>
</tr>
<tr>
<td>Power User View</td>
<td>All panes</td>
</tr>
</tbody>
</table>
To organize the workspace by Task or Notes View, take these steps:

1. Click the **View** menu, click **Layout**, and choose your view.

![Figure 15: Choose a layout](image)

The workspace shows your new view.

2. To reset the view to the default layout, click the **View** menu, click **Layout**, and choose **Reset**.

   The workspace reverts to the original layout.

### Tailoring the Edit Item Window

The Edit Item window is where you most often manage information about projects and tasks, such as dates and status. The Edit Item window uses fields and
tabs to show this information. You can set up the fields and tabs in the Edit Item window to show only the information you want to track in your items, and you can do this by either choosing an overall layout, or by changing specific fields and tabs, or both.

This section explains how to do the following:

- Choose the overall layout.
- Add, rename, remove, or rearrange tabs, including tabs you’ve created.
- Add, rename, remove, or rearrange fields, including fields you’ve created.
- Add, rename, remove, or rearrange buttons, including ones you’ve created.

Before you begin, consider the following:

- If you are an administrator, the changes you make to your Edit Item window do not appear in other users’ Edit Item windows, but you can replicate these changes to other users later. See "Managing Users and User Permissions" on p. 148.
- If you use the Setup Wizard after you have tailored the Edit Item window, the changes you make there overwrite your changes to the Edit Item window.

To tailor the Edit Item window, take these steps:

1. Create an item or open an existing item.

The Edit Item window opens.

![Figure 17: Edit Item window, GTD view](image)

**Note** The image in Figure 17 uses the default GTD layout. Your window might look a little different. These differences don’t affect the rest of the procedure, though.
2. To change the layout, which changes fields and tabs all at once, right-click in the upper pane, and select one of these layouts:

- **Calendar** (to include fields and tabs used most often in managing appointments)
- **Gantt Chart** (to include fields and tabs used most often in managing projects)
- **Getting Things Done (GTD)** (to include fields used most often in managing tasks)
- **Classic** (to use the layout TaskMerlin used before version 5.0)
- **Minimal** (to use only the Summary and Content fields in the Edit Item window)

This image shows these options.

![Figure 18: Choose the layout of the Edit Item window](image)
3. In the confirmation window that opens, click **OK**. The Edit Item window opens with the new layout. In this image, the user switched from the GTD layout to the Gantt Chart layout.

![Figure 19: New layout](image1.png)

4. To add a tab, right-click anywhere above the Content field, and click **Add New Tab**.

![Figure 20: Adding a tab](image2.png)
5. In the window that opens, type the name of the tab, and click **OK**.

![New Tab Page](image)

*Figure 21: New Tab Page*

The new tab appears in the Edit Item window.

![New tab](image)

*Figure 22: New tab*

To add fields to the tab now, go to step 11.

6. To rename an existing tab, right-click the tab and click **Rename [tab name]**.

![Rename tab](image)

*Figure 23: Renaming a tab*
7. In the window that opens, type the new name, and click **OK**.

![Image of Rename Tab Page](image)

*Figure 24: Renaming a tab*

The tab shows the new name.

![Image of Renamed Tab](image)

*Figure 25: Renamed tab*

8. To remove a tab, right-click, and select **Remove [tab name]**.

**Note**

When you remove a tab, you also remove the fields in that tab.
9. In the window that opens, click **Yes** to confirm.
   The tab no longer appears in the Edit Item window.

10. To rearrange the order of the tabs, click a tab and drag it to a new place.

![Figure 27: Dragging a tab to a new location](image)

11. To add a field anywhere in the Edit Item window, right-click where you want the field, click **Add Field** from the list that opens, and select the field.
   You can add fields either under tabs or in the main section on the left.

![Figure 28: Adding a field](image)
12. To add a field you’ve created, right-click, click **Add Field**, but click **User Defined** in the list that opens, and choose your field.

![Click Add field, click User-Defined, and choose the field.](image)

**Figure 29: Adding a field you’ve created**

13. To remove a field, right-click the field, and click **Remove [field name]** from the menu that opens.

14. In the confirmation window that opens, click **Yes**.

15. To rename a field, right-click the field, and click **Rename [field name]** from the menu that opens.

16. In the window that opens, type the new name, and click **OK**.

   The field now uses the new name.

17. To rearrange fields, click and drag the field to the new tab or location.

**A Project Manager’s Guide to Setting Up the Workspace**

As a project manager, you can set up and manage every aspect of your project in the TaskMerlin workspace. For example, you can:

- Set up your workspace using the Setup Wizard.
- Organize the workspace to see tasks or notes, or both.
- Tailor the Edit Item window so it includes the fields and tabs you use most.

The rest of this guide explains how to manage projects in TaskMerlin in more detail.
CHAPTER 3: Navigating the TaskMerlin Workspace

This chapter includes the following topics:

- "Navigating Using the Folders List," this page
- "Navigating Items Using Filters" on p. 33
- "Navigating Items Using the Item Grid" on p. 45
- "A Project Manager's Guide to Navigating the Workspace" on p. 58

Navigating Using the Folders List

Folders group items in topics or categories that you choose. The Folders list provides a way to organize items and to see those items in the Item Grid.

You can use the icons above the folders list to move through your project folders.

- Create items in the Folders lists.
- Open (and close) folders up to seven levels.
- Move folders up or down in the list.
- Show items that are not folders in the Folders list.

To navigate your Folders list, take these steps:

1. To see a folder's items in the Item Grid, click the folder. Its items appear in the grid.

Click a folder to see its contents in the Item Grid.

Figure 30: Contents of the folder in the Item Grid
2. In the Folders list, click the **Add or Remove Buttons** arrow, and click **Add all buttons**, as shown here.

   ![Figure 31: Adding all buttons to the Folders list](image)

   *All available buttons for the Folders list open.*

3. To create a task, folder, or project in the Folders list, click the icon for that type, and enter the item's information in the window that opens.

   This image shows where to find these icons.

   ![Figure 32: Icons for adding an item in the Folders list](image)
4. To open and close all folders at once, click the **Expand or Collapse** icon, and choose the level from the list that opens.

![Figure 33: Opening the Folders list to all levels](image)

The folders open to the level you choose.

5. To move folders up or down, select a folder and click the blue arrow icons.

![Figure 34: Shifting folders up or down in the Folders list](image)

The selected folder moves up or down in the list.
6. To see all items in the Folders list, including items that are not designated as Folders, click the Show non-folder items icon.

![Show non-folders icon](image)

*Figure 35: Showing items that aren’t folders in the Folders list*

All items appear in the list.

You can also navigate items by creating and using filters, which is explained next.

**Navigating Items Using Filters**

Filters use the attributes of items, such as Status or Priority, to create lists of items with similar properties. You can use filters to see items in the Item Grid of a certain type with a certain status or other property only. For example, you can use a filter to see all Task items whose status is Next Action. Or you can see only Project items with a priority of Highest.

TaskMerlin includes several filters by default, but you can also create your own.

- The **All items** filter shows all items in the Item Grid.
- The **My Items** filter shows items that you own or have assigned to you.
- The **High Priority Items** filter shows only items with a Priority of High or Highest.
- The **To Do Today** filter shows items that are due on this day, whose status is not completed, and that are not designated as Folders.

This section explains how to create filters and use them to manage your projects.

Once you understand how filters work, you can change the properties of these filters as well as create your own. For now, let’s explore and change the High Priority Items filter.
To use and update an existing filter, take these steps:

1. Click the **High Priority Items** filter in the Filters list, as shown here.

![Click the High Priority Items filter.](image1)

2. Click the **Open window to edit the selected filter** button, as shown here.

![Click this button](image2)
Figure 37: Opening a filter to edit it

The Item Filter Wizard opens.

![Image of the Item Filter Wizard]

Figure 38: Item Filter Wizard

3. Under Step 2 - Type the filter name, type High Priority Items in the text field.
4. Click the Advanced tab.

The Edit Filter window opens.

![Image of the Edit Filter window]

Figure 39: Edit Filter window
5. In the Name field, change “Items” to “Tasks.”
6. In the Image list, choose a different image if you want one.
7. In the Description field, describe the filter.
8. Click the **Add row** button.
9. In the first row, do the following:
   - In the first column, click the field, click **Item** and click **Item Type** in the list that opens.
   - In the Function column, click **Is**.
   - In the Value column, click the list and click **Task**.
   The first row shows Item Type Is Task.

![Figure 40: Filter using Item Type of Task](image)

**Tip** To add a field you’ve created, click the field name in the first column, click **User Defined**, and click the field name. See “Adding Your Own Item Fields” on p. 83 to learn about adding fields. Also, you can add Predecessor as a filter criteria, which means you can include items that either are predecessors or have a specific predecessor.

10. Click the **Apply** button.

   This filter now shows any Task items that have a priority of High or Highest. Next you can establish how the items are sorted in the Item Grid when you use this filter.
11. Click the **Sort Designer** tab.

The Sort Designer fields open. The Sort Designer determines which attributes items are sorted by first.

![Sort Designer fields](image)

*Figure 41: Sort Designer fields*

12. Click **Add row**.

Assume that you want this filter to sort the tasks first by who they’re assigned to, and then by priority. This means that all tasks assigned to one user with a priority of High or Highest appear first in the grid. Tasks assigned to the next user appear below that.
13. In the first column, click **Assigned To**, and leave Ascending as it is in the Direction column.

14. Click the **Add row** button again, and add a column called **Priority** for sorting in Ascending order.

   This image shows how.

![Add a column called Priority.](image)

**Figure 42: Sorting items in this filter by Assigned To and Priority**

15. Click the **Apply** button.

   Next you can decide whether other users can use this filter, and whether the filter includes deleted or archived items.

16. Click the **Options** tab.

   The Options fields open.

![The Options fields open.](image)
**Navigating the TaskMerlin Workspace**

17. To let others use this filter, check the **Publicly available to all login users** check box. Otherwise, only you can use this filter.

18. To include items in the Archived Items folder or in the Bin (deleted items), select the **Include archived items** and **Include deleted items** check boxes.

19. To set up filter options that apply to all filters, click the **General Options** tab, and complete those fields.

20. Click **OK**.

The updated filter appears in the Filters list.

---

**Creating Your Own Filters**

Once you see how filters work, you can create your own. If you are an administrator, you can create filters for other users to use.

To create a filter, take these steps:

1. Click the **Create a new filter** button.
Figure 45: Creating a filter

The Item Filter Wizard opens, as shown here.

2. Under **Step 1 - Specify the filter information**, click the check boxes and choose the properties.

3. Under **Step 2 - Type the filter name**, enter a descriptive name for this filter. In the image below, the user chooses the Item Type value of Task, the Status value of Pending, and the Assigned To value of AmyAdmin. The new filter is called “Amy’s Pending Tasks.”
4. Do one of the following:
   • If you are finished creating the filter, click the **OK** button.
   • To add more properties, click the **Advanced** button, and see "Editing an Existing Filter" on p. 33 for instructions.

**Filtering within Folders**

You can filter items in the Item Grid by the contents of one folder only. For example, you can see items that you own within a selected folder instead of the entire database.

This section explains how to set up this option, and then use it in the Item Grid.

☐ To set up and use filtering within folders, take these steps;

1. Open the **Tools** menu, and click **Options**.

   The Options window opens.

   ![Options window](image)

   *Figure 48: Options window*
2. Click **Item Grid**.

   The Item Grid fields open.

3. Click **Grid tool bar filtering within folders**, and click **OK**.

   In the Item Grid, the Filters button becomes Filter By.
Figure 51: Filter By tool bar button

4. In the Folders list, click the folder you want to use for the filter. The items in that folder appear in the Item Grid.

5. Click the **Filter By** button, and click a filter name. For example, click **Filter By**, and click **High Priority Items**.

Figure 52: Filtering within a folder

The items matching that filter’s criteria in that folder only appear in the Item Grid.

Figure 53: Filtering within a folder

Organizing Your Filters List

You can organize your filters list by creating shortcuts for filters, adding bars between filters to group them, and turning a filter on as you navigate the Folders list.
To organize your Filters list, take these steps:

1. To create a shortcut for a filter, make sure the filter exists, and then click the **New Filter** button, point to **New Shortcut**, and find the filter in the list that opens.

![Adding a shortcut to a filter](image1.png)

*Figure 54: Adding a shortcut to a filter*

The shortcut for the filter appears in the Filters list.

2. To add a separator between filters, do the following:
   - Click the **New** button and click **New Separator**, as shown here.

![Click New and then New Separator](image2.png)
A separator appears in the Filters list.

- Drag the separator between the filters you want to separate, like this:

![Figure 55: Adding a separator between filters](image)

You can also organize the order of your filters by dragging the filter above or below other filters.

### Navigating Items Using the Item Grid

The Item Grid is where you can see items and information about them at a glance. You can customize the Item Grid to show or hide item information. This section explains the following:

- "Using the Preview and Preview Details Panes" on p. 45
- "Tailoring the Preview Details Pane" on p. 47
- "Tailoring the Item Grid" on p. 52
- "Using Sorting to Manage the Item Grid" on p. 55
- "Converting Items to Folders in the Item Grid" on p. 57

The Preview pane shows an item's contents (the information in the Contents field) at the bottom of the Item Grid when you select an item in either the Item Grid or the Folders list.

The Preview Details pane shows the attributes of the selected item.

This section explains how to open the Preview and Preview Details panes.
To use the Preview and Preview Details panes, take these steps:

1. Click the **View** menu, and click **Preview**.
   
   The Preview pane opens under the Item Grid.

---

**Tip**  
You can edit the information in the Preview pane if you click the Pencil icon above it.
2. To see the selected item’s attributes, click the View menu, and click Preview Details.

**Tip**
To open the Preview and Preview Details panes in one step, open the View menu and click Preview Details. Both panes open at once.

The Preview Details pane opens.

![Figure 58: Preview Details of a selected item](image)

Here you can see an item’s details, such as its time estimates and the users associated with it.

See the next section to learn how to change the fields and categories in Preview Details.

**Tailoring the Preview Details Pane**

Just like with the other parts of the workspace, you can determine which fields you see in Preview Details for any item by doing the following:

- Choosing the layout (GTD, Calendar, and so on)
- Adding or removing fields, including your own fields
- Rearranging fields
- Adding your own categories to separate the fields

To tailor Preview Details, take these steps.

1. Make sure you can see the Preview Details pane. If you can’t, click the View menu, and click Preview Details.
2. To change the layout of preview details, right-click any field, click **Layout**, and choose the layout.

For example, switch from the GTD layout to Gantt Chart.

![Choosing a layout](image1.png)

**Figure 59: Choosing a layout**

3. In the window that opens, click **OK**.

Preview Details shows the new layout.

![New Preview Details layout](image2.png)

**Figure 60: New Preview Details layout**
4. To add a field, right-click any field, click **Add Field**, and find the field in the list that opens.

To find a field you’ve created, open the **User Defined** list. Your field is in that list. (For instructions on creating fields, see "Adding Your Own Item Fields" on p. 83.)

![Right-click a field, click Add Field, and find the field.](image)

*Figure 61: Finding a field to add*

**Tip**
If Preview Details already uses a field, that field in the list has a check mark next to it.

The field appears above the field you selected.

![New field in Preview Details](image)

*Figure 62: New field in Preview Details*
5. To remove a field, right-click the field, and click **Remove [field name]**.

6. To rearrange the fields, click a field and drag it to a new location. You can click and drag a field above or below other fields, and into a new category.

7. To add a category, right click in Preview Details, and click **Add New Category**.
8. In the New Category window that opens, type the category's name, and click **OK**.

The new category appears in bold text in Preview Details.

![New category in Preview Details](image)

*Figure 65: New category in Preview Details*

9. To rename any category, right click the category and click **Rename [category name]**.

![Right-click the category, and click Rename [category name]](image)

*Figure 66: Renaming a category*

10. In the Rename Category window that opens, type a new name, and click **OK**.

The category uses the new name.
11. To remove a category, right-click the category and click **Remove [category name]**.

**Caution**
When you remove a category, you also remove any fields in the category.

---

**Tailoring the Item Grid**

The Item Grid lists information about items. The columns in the Item Grid determine which information you see about items in the grid. You can tailor which columns you see in the Grid in these ways:

- Choose the overall layout for the Item Grid.
- Add column or remove columns.
- Rearrange columns.

This section explains how.

To tailor the Item Grid, take these steps:

1. Right-click in the Item Grid heading.

   The shortcut menu opens.

---

**Tip**
If you open the Manage menu and click Columns, you can complete all the steps in the procedure except choosing the layout.
2. To use a built-in set of columns, click **Layout**, and then click one of the following:
   - **Notes** (Item Type, Summary)
   - **Calendar** (Item Type, Summary, Progress, Assigned To, Start, Finish, Deadline)
   - **Gantt Chart** (Item Type, Summary, Status, Priority, Context, Progress, Assigned To, Start, Finish, Deadline)
   - **Getting Things Done (GTD)** (Item Type, Summary, Status, Priority, Context, Progress)
   - **Classic** (Item Type, Summary, Status, Priority, Progress, Assigned To, Deadline)

3. In the confirmation window that opens, click **OK**. The Item Grid shows the new columns.

4. To add a column, right-click in the Item Grid heading approximately where you want the next column, click **Add Column**, and find the column you want in the list that opens.
5. To add a field you created (see "Adding Your Own Item Fields" on p. 83), click **User Defined**, and find the field in the list that opens.

![Figure 71: Adding a field you've created](image)

6. In the window that opens, click **OK**. The new column appears in the Item Grid.

![Figure 72: New column in the Item Grid](image)

7. To remove a column, right-click the column, and click **Remove [column name]** from the menu that opens.

![Right-click the column and click Remove [column name]](image)
Navigating the TaskMerlin Workspace

8. To move a column in the Item Grid, click and drag the column to its new place.

Using the sorting options, you can determine in what order items appear in the Item Grid. You can do the following:

- Sort columns by clicking a column header to sort by that column, such as Status or Priority.
- Use TaskMerlin’s default item order.
  The default item order comes from the Order column. The Order column shows the order in which items are created by clicking a column header to sort by that column. (This method applies whether the Order column itself is visible.)
- Create your own item order and use it as the default or just when you need to.

The following procedure explains how to create your own item order, which is called a “managed item order.”

To create a managed item order and apply it, take these steps:

1. In the Item Grid, click the Sort by managed item order button, and click Set Managed Item Order.
   This image shows how.

2. Click the Add row button.
   A row appears
3. Click the list under Column, and choose a value. This image shows how.

![Click the list and choose a value.](image1.png)

**Figure 75: Selecting columns for the managed item order**

4. In the Direction column, choose either Ascending or Descending. Ascending order means that items appear alphabetically.

5. Repeat the previous steps to add more rows.
   The row that appears on top is the dominant item order. Items are sorted by this column first.
   To move rows up or down, select the row, and click the blue up or down buttons.

6. Click OK.
   The Item Grid appears.

   ![Click the list and choose a value.](image2.png)

7. To apply this item order in the Item Grid now, click the Sort by managed item order button, and click Sort by Managed Item Order, as shown here.

   ![Click the list and choose a value.](image3.png)

   **Figure 76: Sorting by managed item order**

   The items are sorted by your custom sorting order.
8. Repeat step 7 to apply the managed order to other lists of items.

You can convert a folder to an item or an item to folder from the Item Grid tool bar. When you convert an folder to an item, you must make sure the folder is not an owner of other items first.

Converting items to folders or folders to items does not change the item type. It only assigns or removes the item's ability to be a parent to other items.

You can also add a folder or a Project item to the grid from the Item Grid tool bar. This section explains how.

To convert folders and add folders and Project items, take these steps:

1. Select the item in the Item Grid.

   ![Figure 77: Selecting the item in Item Grid](image)

2. Click the Create folder button, and click either Convert folder to item or Convert item to folder.

   ![Figure 78: Convert an item to a folder](image)

   The item or folder is converted, but the item type does not change.
3. To create a Folder or Project item in the Item Grid, select the item, click the Create a new folder button, and select Create a new folder or Create a new project.

![Image of a folder creation process](image)

Figure 79: Creating a new project

The Edit Item window opens so you can add the details. See "Creating and Managing Items" on p. 62 for instructions.

**A Project Manager’s Guide to Navigating the Workspace**

Once you have set up your project, you can see and update its items in the Folders list, Filters list, or the Item Grid itself. Here are some tips for managing your projects in the workspace.

- Use the Folders list to keep a master list of all items related to the project.
- Create a folder for the project and keep every item for the project—tasks, notes, people—in that folder. When you want a high-level view of the project, click the folder to see everything in the Item Grid.
- Use the Filters list to see items of a certain type for the project, such as the people assigned to it, only completed tasks, or only tasks in progress.
- Sort a project’s items in the Item Grid using the column headers, or create a managed item order to see the items in the order you prefer.
- Change an item’s Folder status from the tool bar, or add Folder and Project items from the tool bar.
CHAPTER 4: WORKING WITH ITEMS AND ITEM TYPES

This chapter includes the following topics:

- "Finding Items," this page
- "Creating and Managing Items" on p. 62
- "Spell-checking Items" on p. 76
- "Renaming Item Fields and Adding Your Own" on p. 81
- "Creating and Managing Item Types" on p. 85
- "Adding and Editing Item Type Attributes Values" on p. 89
- "A Project Manager's Guide to Setting Up Projects" on p. 95

Finding Items

You can search for items using the Search tools. When you search for an item, you can search its summary, its contents, or its tag (which is a good reason to include tags when you create items).

Here are some guidelines to help you search for items:

- Use the most specific term you can, such as the item’s exact title, and include a search in the Summary section.
- If you don’t know the exact term, select **Any Words** in the Kind of match section.
- If it’s possible the item has been deleted or archived, include the Archives and Bin in the search.

To search for an item, take these steps:

1. Click the **Edit** menu, and click **Find Items**. The Find Items window opens.

![Find Items window](image)

*Figure 80: Find Items window*
2. In the Search in fields section, select **Summary, Content, Tag**, or any combination of these.

3. In the Kind of match section, choose **Exact Phrase, All Words**, or **Any Word**. Exact Phrase produces the most focused search results. All Words looks for all the words in the order you write them in Search text box. Any Word produces to broadest search results.

4. In the Search for the following text field, type a word or phrase, such as “Corporate Web Site.”

5. In the Search section, choose where to search: All items in your database, the Item Grid, or the selected folder only.

6. In the Include section, check **Archives, Bin**, or both, if you think the item has been archived or deleted.

   This image shows how to complete these fields. In this example, the user is searching for the word “Analysis” in the Summary and Tag fields of all items, but not the Archives or Bin folders.

![Completed fields in the Find Items window](image)

    Figure 81: Completed fields in the Find Items window

7. Click **Find**.

   The matching items appear in the Item Grid, as shown here.

![Results of search in the Item Grid](image)

    Figure 82: Results of search in the Item Grid
8. Double-click the item to open it now.

Tip If you find the item in the Item Grid, you can find its location in the Folders list. Press Ctrl+L to do so.

Creating and Managing Items
This section includes the following topics:
- "About Items," this page
- "Creating an Item," this page
- "Opening and Editing an Item" on p. 71
- "Using In-Place Editing in the Item Grid" on p. 72
- "Editing Multiple Items’ Attributes in the Item Grid" on p. 73
- "Deleting Items from Your Projects” on p. 74
- "Archiving Items" on p. 75

About Items The item is the core of any project in TaskMerlin. The term “item” is a generic term for specific parts of a project. Any item uses an item type (see p. 81) as a template, but it’s the item itself that represents a part of a project in TaskMerlin.

Creating an Item In this procedure, let’s create a Project item and call it “Corporate Web site.”

Note The images of the Edit window in this procedure use the Classic layout. Your Edit Item window might look different.

To add a Project item, take these steps:
1. To make sure the item you create automatically appears as part of a specific folder, click the folder in the Folders list first.
2. In the Items Grid, click the arrow next to the **Create a new item** icon and click **Project** from the list that opens.

**Tip** You can also click the Create a new folder button and click Create a new project.

The Edit Item window opens.

Because this is a Project item, the Folder and Owner Item options are selected automatically.

The Folder check box gives the item Folder status, which does the following:

- Makes sure the Project item appears in the Folders list.
- Allows the Project item to contain other items.

If an item is the Owner item, the item can be the parent item for other items. Then the item’s title appears in the Owner Item Summary column of the Item Grid when you view its child items. An item cannot be an Owner item unless it also has Folder status.
Figure 84: A Project item with Folder and Owner attributes

3. In the Summary field, type a title for the Project item. In this example, type “Corporate Web Site.”
This image shows the Folder, Owner, and Summary fields.

Figure 85: Folder, Owner, and Summary fields

4. Click the Tag check box, and type a label or a category for this item.
Tip Tags help you keep items in your own categories. You can search for items and sort them later by their tags.

This image shows the completed Tag field.

Figure 86: Tag check box and field
5. In the Content field, type notes about the project. This is a good place to write a summary of what the project will accomplish or a list of the things you need for the project. If you use key project words here, you can also search for words in the Content field later.

This image shows a completed Content field.

Tip You can format the text in the Content field, including changing the font and font size, in the tool bar above the Content field.
6. Click the **Apply** button to save your changes so far.

7. Go to the Attributes tab and do the following:
   - In the Context list, choose the context, such as Office.
   - In the Status list, choose a status, such as Not Started or In Progress.
   - In the Priority list, choose a priority, such as Highest, High, or Medium.
   - In the Impact list, choose the item’s impact, such as Major or Critical.

(For descriptions of these attributes, see "About Item Types" on p. 85.)

You can later filter and sort items by the properties you enter here. This image shows these attributes.

![Figure 88: Attributes lists](Image)
8. Click the **People** tab.

The Owned By, Assigned To, and Contact fields open.

You can use the People tab to determine who tracks this item (Owned By), who is responsible for completing the item (Assigned To), and who the contact for this item is (Contact).

This image shows the People tab.

![People fields in People tab](image)

9. Click the **Date** tab.

The Date fields open, as shown here.

![Date fields](image)
Figure 90: Date fields under Date tab

Use the Date fields to schedule the project on the Calendar and the Gantt Chart. For example, do the following:

• Click the **Start** check box and select the date the project is scheduled to start.
• Click the **Finish** check box and select the date the project is scheduled to be completed.
• Click the **Deadline** check box to enter the project’s due date.

This image shows the completed Date fields.

Figure 91: Completed Date fields

10. Click the **Time** tab.

Use the Time fields that appear to enter the project’s estimated, spent, and remaining time.
To set up the item’s recurrence, see "Scheduling Items on the Calendar" on p. 96.

This image shows the Time fields.

![Completed Time fields](image1.png)

**Figure 92: Time fields**

11. Click the **Value** tab, and enter the project’s cost information in the fields that open.

This image shows the Value fields.

![Completed Value fields](image2.png)

**Figure 93: Value fields**

12. Click the **Colors** tab, and do the following:
   - Click the **ForeGround** and **Background** check boxes and select the foreground (text) and background colors.
The item shows these colors in the Item Grid, the Folders list, and the Calendar. They can help you quickly identify this item in the workspace.

- Click the **Child Foreground** and **Child Background** check boxes, and choose the foreground and background colors for any items that this Project item owns.

  These colors also appear in the Item Grid, Folders list, Calendar, and Gantt Chart. They can help you quickly identify items associated with this project.

This image shows the Color fields.

![Completed Colors fields](image)

*Figure 94: Colors fields*

13. Click the **Links** tab to see the **Predecessor** check box.

  A Predecessor is an item, such as a task, that must finish before the next task can start. When you link tasks in this way, they become dependencies. The Gantt Chart shows dependencies between items by including an arrow linking their task bars.
14. To add a predecessor item to items that are not Folders or Projects, click the Predecessor check box and find the item in the list that opens.

**Note**  
You cannot link a Project or Folder item to any other item.

This image shows the Predecessor field.

![Predecessor field in the Links tab](image)

**Figure 95: Predecessor field in the Links tab**

15. Click the **OK** button.

16. To see your Project item, go to the Item Grid.

This image shows the Item Grid with the new Project item.

![New item in the Item Grid](image)

**Figure 96: New item in the Item Grid**

Notice that the item is yellow because that is color you selected in the Background field of the Colors tab when you set up the item.

**Opening and Editing an Item**  
You can open and edit an item to change anything about it, such as its parent (owner item), status, or priority. You might want to edit an item when priorities shift, or to assign the item to a new user. Opening an item is the best way to edit it when you need to change several things about it.
If you need to change just one or two things about an item, you can make the changes in the Item Grid without opening the item. See "Using In-Place Editing in the Item Grid" on p. 72.

To open and edit an item, take these steps:
1. Find the item in the Folders list or the Item Grid.
2. Double-click the item to open it.
   The Edit Item window opens, as shown here.

4. Click the OK button to save your changes.

Using in-place editing, you can edit information about items in the Item Grid itself, as long as the columns you need are visible. (To make certain columns visible, see "Tailoring the Item Grid" on p. 52.)

This section explains in-place editing.

To edit items in-place, take these steps:
1. Make sure you can see the item in the Item Grid.
2. Click the Pencil icon in the tool bar, as shown here.
3. Make changes to the items using the drop-down lists in the columns. This image shows how.

Your changes appear in the Item Grid.

You can change the same attributes of several items at once in the Item Grid, as long as the columns you need are visible. (To make the columns visible, see "Tailoring the Item Grid" on p. 52.) This way you don't have to open each item just to change one attribute. The following procedure uses the Status attribute to illustrate.

To change an item's attribute in the Item Grid, take these steps:

1. Select the items in the Item Grid by pressing Ctrl+L +A for all, or by pressing Ctrl+L and clicking each item to select it.

All the items are selected.

Figure 98: Pencil Icon in the tool bar

Figure 99: Using in-place editing

Figure 100: All Items selected in Item Grid
2. Do one of the following:
   • In the Status column, right-click the items, click **Set Status** in the menu that opens, and find the new status.
   • Click the **Status** icon in the tool bar.

This image shows how to use the right-click menu.

![Figure 101: Selecting Status from the right-click menu](image)

The items show the new status, as shown here.

![Figure 102: Status changed for several items in the Item Grid](image)

**Deleting Items from Your Projects**

When you delete an item, the item moves to the Bin folder (the trash). If you would rather keep the item active but store it away from your working folders, archive it instead. See "Archiving Items" on p. 75 for instructions.

**Note**

As long as you don’t **permanently** delete items by emptying the Bin folder, you can still search for items you’ve moved to the Bin folder if you need to.

- To delete an item, take these steps:
  1. Find the item in the Item Grid.
2. Right-click the item.
3. In the shortcut menu that opens, click **Delete**, as shown here.

![Figure 103: Deleting an Item](image)

4. In the confirmation window that opens, click **OK**.
   The item is moved to the Bin folder.

**Archiving Items**

To archive an item is to move an item to the Archives folder. You can still search for the item later if you need to, and it is not deleted, just stored outside of your working folders.

- To archive an item, take these steps:
  1. Find the item in the Item Grid.
  2. Right-click the item and select **Move to Folder**.
  3. In the Move window that opens, click the **Archives** folder, as shown here.

![Figure 104: Archives folder](image)

4. Click **OK**.
   The item is moved to the Archives folder.
Spell-checking Items

You can let the Spell Checker check your text as you write in the Content pane, Preview pane, or Quick Notes. This section includes the following topics:

- "Setting Up the Spell Checker," this page
- "Using the Spell Checker" on p. 77
- "Clearing the Added and Ignored Words Lists" on p. 79

Setting Up the Spell Checker

The Spell Checker is active when you first use TaskMerlin, but this section explains how to turn it off or on and set up its dictionary and language.

To set up the Spell Checker, take these steps:

1. Click the Tools menu, and click Options.
   The Options window opens.

   
   ![Figure 105: Options window](image)

2. Click Database, and click Spell Checker in the list that opens.

   Click Database, and click Spell Checker.
Figure 106: The Spell Checker options

3. To turn on Spell Checker, make sure the Enable spell checking box has a check mark.

4. To choose a language, click Language and select one from the list.
   The language provides the main dictionary the Spell Checker uses to verify spelling. The default is English.

5. To use your own dictionary, click the button next to the Dictionary field, and find the one you want on your system.

   Figure 107: Adding a dictionary

6. In the confirmation window that opens, click OK.

7. To save your changes, click OK.

8. In the confirmation window that opens, click OK.

9. Click OK to save your changes and close the Options window.

Using the Spell Checker

When you turn on the Spell Checker, what you type in the Contents pane, the Preview pane, or the Quick Notes window is spell-checked as you type. Misspelled words are underlined with a red, wavy line.

As you type, you can correct words, tell the Spell Checker to ignore them, or add them to the Spell Checker dictionary.

(You can later clear words you’ve added to the dictionary or chosen to ignore. See "Clearing the Added and Ignored Words Lists" on p. 79.)

This section explains how to use the Spell Checker.
To use the Spell Checker, take these steps:

1. Open an item and go to the Contents pane in the Edit Item window.

2. Type your text. When you misspell a word, a red, wavy line appears under the word.

3. To fix the misspelled word, right-click the word and do one of the following in the list that opens:
   - To correct the word, choose the correct spelling.
   - To add the word to the dictionary, click Add to Dictionary.
   - To have the Spell Checker ignore the word, click Ignore All.
If you click Add to Dictionary, the word is added to TaskMerlin’s default dictionary. If you click Ignore All, the word is ignored but not added to the dictionary. In either case, Spell Checker does not mark the word as misspelled until you clear these lists.

**Note**

4. Click **Apply** or **OK** to save your changes.

**Clearing the Added and Ignored Words Lists**

- To clear the Added Words and Ignored Words lists, take these steps:
  1. To clear your Ignored Words list, click the **Tools** menu, and click **Options**. The Options window opens.
2. Under TaskMerlin User, click **Miscellaneous**.
3. In the Spell Checker section, click the **Clear Ignored Words** button.

![Figure 111: Options window](image)

4. In the confirmation window that opens, click **OK**.
5. Click **Database**, and click **Spell Checker**.

![Figure 112: Clearing the Ignored Words list](image)

![Figure 113: Spell Checker option under Database](image)
6. To clear any words that have been added to the built-in dictionary, click **Clear the Added Words list**.

![Clear the Added Words list](image)

Figure 114: Clearing the Added Words list

7. Click **OK** in the Options window to save your changes.

**Renaming Item Fields and Adding Your Own**

Item fields are the names of fields you see as columns in the Item Grid or fields in the Edit Item window and Preview Details pane. For example, Completed Date, Priority, Impact, and Progress are item fields.

You can give an item field a name that’s more meaningful to you. For example, you can rename the My Reminder Date field to Remind Me On.

You can also add new fields by renaming the four undefined text and four undefined numeric fields included in TaskMerlin.

Once you make changes to the fields, you can use them in the Item Grid as a column, add them to the Edit Item window or Preview Details pane, and search by them by adding them to a filter.

This section explains how to do the following:

- Rename existing item fields.
- Add your own item fields.

**Renaming Existing Item Fields**

To rename an existing field, you replace the default name with your own. This section explains how.
To rename an existing field, take these steps:

1. Click the **Manage** menu, and click **Item Field Names**.

![Click Manage, and then Item Field Names.](image1)

**Figure 115: Manage Menu, Item Field Names option**

2. In the Manage Item Field Names window that opens, scroll down to find the field you want, and click the field.

![Scroll down to find your field and click its name.](image2)

**Figure 116: Manage Item Field Names window**
3. In the New Name column, type your new name for the field. For example, type “Remind Me On.”

![Figure 117: New name for the item field]

4. Click OK.

If the Item Grid, Edit Item window, or Preview Details pane already uses this field, the new name appears in these places automatically.

5. To add the item to the workspace now, do one of the following:
   - To use the field as a column in the Item Grid, see "Tailoring the Item Grid" on p. 52.
   - To add the renamed field to the Edit Item window, see "Tailoring the Edit Item Window" on p. 21.
   - To add the item to the Preview Details pane, see "Tailoring the Preview Details Pane" on p. 47.
   - To use the field in a filter, see "Creating Your Own Filters" on p. 39.

6. To use the original name again, repeat these steps, but delete the name from the New Name column.

   The item field uses its original name again.

**Adding Your Own Item Fields**

You can use the four unnamed text fields and four unnamed number fields to add your own fields to your workspace.

A text field uses words in the field. For example, the Tag field is a text field, because you can type any words you want to there.

A numeric field uses numbers only. Time Estimated and Planned Value are number fields, for example, because you can use only numeric values in them.

This section explains how to add these types of fields. Once you add them, you use them the same way you use TaskMerlin’s built-in fields.
To add your own fields, take these steps:

1. Click the Manage menu, and click Item Field Names.

2. In the Manage Item Field Names window that opens, scroll down to find Number Field 1 or Text Field 1.

   This image shows the blank Text fields.

   Figure 118: Manage Menu, Item Field Names option

   Figure 119: Unnamed text fields
3. Click one of these fields, and type the name for it in the New Name column.

![Image](image.png)

*Figure 120: New name for an unnamed text field*

4. Click **OK**.
   - To add the field as a column in the Item Grid, see "Tailoring the Item Grid" on p. 52.
   - To add the field to the Edit Item window, see "Tailoring the Edit Item Window" on p. 21.
   - To add the field to the Preview Details pane, see "Tailoring the Preview Details Pane" on p. 47.
   - To use the field in a filter, see "Navigating Items Using Filters" on p. 33, and "Creating Your Own Filters" on p. 39.

### Creating and Managing Item Types

This section explains the following:
- "About Item Types," this page
- "Adding Item Types To TaskMerlin" on p. 85
- "Editing or Deleting Item Types" on p. 87
- "Changing Default Item Types" on p. 88

#### About Item Types

An item type is a template for items of that type. For example, the item type Person can be the template for an item representing someone who works on the project, even if that person is not a TaskMerlin user, and the item type Task is the template for any task in the project.

#### Adding Item Types To TaskMerlin

When you add an item type, you create a new template for items. You can create item types that help you group types of information in your projects. For example, you can create an item type called Meeting Notes, and then create an item
based on the Item Type of Meeting Notes every time you want to type minutes from a meeting.

Tip
Spend some time exploring TaskMerlin’s default item types. That way, you won’t duplicate an existing item type with one you create.

Use this procedure to add an item type to TaskMerlin.

To add an item type, take these steps:

1. Click the Manage menu, point to Customizable Types, and click Item Type.

![Figure 121: Manage Item Types menu](image)

The Manage Item Type View window opens.

2. Click the New button.

The New Item Type window opens.

![Figure 122: New Item Type window](image)

3. In the Name field, type the name for your item, such as “Milestone.”

4. In the Image list, scroll through the list to find the image that best represents the name.

5. To make each instance of this item a folder, click the Create as a folder by default check box.

The Create as an Owner item by default check box appears.

Any items that are folders appear in the Folders list automatically and can be Owner items for other items.
6. To allow the item type to own other items, click the **Create as an owner item by default** check box.

This image shows how to complete the New Item Type window.

![New item type attributes](Image)

**Figure 123: Completing the New Item Type window**

7. Click **OK**.

Your item appears in the list of items in the Manage Item Type View window.

8. Click **OK**.

To learn how to customize this item, see the next section.

### Editing or Deleting Item Types

You can edit or delete an item type in these ways:

- Change the item type's name, icon, or folder status.
- Create or delete a shortcut for the item type. (You can get to a shortcut from the right-click menu under New. Adding a shortcut for an item type means that you can create an item of that type quickly.)
- Remove the item type from the workspace altogether

This procedure explains how to do these things.

To edit or delete an item type, take these steps:

1. Click the **Manage** menu, click **Customizable Types**, and click **Item Type**, as shown here.

![Click Manage, click Customizable Types, and then click Item Type.](Image)

**Figure 124: The Manage Item Types menu**
2. In the Manage Item Type View window that opens, select the item type you want to edit.

![Select the item type you want to edit.](image)

**Figure 125: Selecting an item type to edit**

**Tip**
To expand all lists in the Item Type list, click the arrow to the right of Delete Shortcut, and click the Expand/Collapse icon that appears.

If you do not see the item type in the list, click the View full Item Type list link at the bottom, and, in the window that opens, select the item type and click the Edit button.

3. In the Edit Item Type window that opens, do one of the following:
   - To change the item type’s properties, change the name, the image, or the item type’s Folder or Owner status, and click OK.
   - To delete the item type, click the View full Item Types list link, select the item in the list that appears, and click the Delete button.
     If you delete an item type that existing items use, these items are reset to the default item type of Task.

4. Click OK when you have finished.

**Changing Default Item Types**
To change the default attribute for an item type is to change the default item type, folder type, project type, or calendar type. For example, the default item type is the item type that opens when you select the Create a new item button in the item grid. By default this item type is Task. You can change it to Note or some other item type. You can do the same for folder types, project types, and the item type that appears by default when you add an item to the Calendar.
To change the default types, take these steps:

1. Click the Manage menu, click Customizable Types, and click Item Types.
   The Manage Item Type View window opens. The default item types appear on the right, as shown here.

   ![Default item types](image)

   **Figure 126: Default item types**

2. Do one or more of the following:
   - To change the default item type, click the Default Item Type list and select a new item type.
   - To change the default folder type, click the Default Folder Type list and select a new folder type.
   - To change the default project type, click the Default Project Type list, and select a new project type.
   - To change the default type for the Calendar, click the Default Calendar Type list and choose a new calendar type.

3. Click the OK button.

### Adding and Editing Item Type Attributes Values

An item type's attributes help define an item by priority, context, impact, or status, or other attributes. In this way, the attributes help you classify the item in relation to other items. For example, you can have two Project items, but for one, the Priority is High while the other is Medium. You can sort items in the Item Grid by their attributes and create filters based on these attributes.

When add or change the values for an attribute, those values become available for every item of that item type.

This section includes the following topics:

- "Existing Item Attribute Values" on p. 90
- "Adding Attribute Values" on p. 90
- "Editing Attribute Values" on p. 92
- "Deleting Attribute Values" on p. 94

The following table shows the values that each item attribute includes by default.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Purpose</th>
<th>Default Attribute Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context</td>
<td>To define a location or activity</td>
<td>Computer Online Home Office Calls Errands</td>
</tr>
<tr>
<td>Status</td>
<td>To define the progress of the item</td>
<td>Not Started In Progress Cancelled Completed</td>
</tr>
<tr>
<td>Priority</td>
<td>To rank the task by importance</td>
<td>Lowest Low Medium High Highest</td>
</tr>
<tr>
<td>Impact</td>
<td>To define the effect the item has on a project</td>
<td>Trivial Minor Moderate Major Critical Extreme</td>
</tr>
</tbody>
</table>

When you add an attribute value, you can do so for the attributes of Context, Status, Priority, Impact or other attributes. These values become available the next time you create an item.

As an example this procedure uses the example of adding values to the Status attribute.
To add a value to the attribute of Status, take these steps:

1. Click the **Manage** menu, select **Customizable Types**, and select **Status**.
   
   This image shows how.

![Click Manage, click Customizable Types, and click Status.](image1)

   *Figure 127: Select Status*

2. In the Manage Status View window that opens, click the **New** button.
   
   The New Status window opens.

3. In the Name field, type a name for this status.

4. In the Image list, choose an image to match the name.

5. To mark complete any items with this status type automatically, click **Completed/Closed Type**.
   
   This image shows a completed New Status window.

![The new status type is "In Review.".](image2)

   *Figure 128: Adding a status*
6. Click the OK button.

The new Status type appears in the Manage Status View window, as shown here.

Figure 129: New Status type

The next procedure explains how to edit any existing attribute value.

“Editing Attribute Values”

To edit an attribute’s values is to change the value’s name, image, or Completed/Closed status, or to add or delete a shortcut for it. This procedure explains how to edit the Status attribute values, but you can use this procedure for any attribute.

To edit an attribute’s values, take these steps:

1. Click the Manage menu, click Customizable Types, and select Status.

The Manage Status View window opens.

Figure 130: Manage Status View window
2. Click the value you want to edit, and click the **Edit** button.
   If you don’t see the value in this window, click the **View full Status list** link to open the full list, and then select the value and click **Edit**.
   For example, click the **In Progress** type, and click **Edit**.
   The Edit Status window opens, as shown here.

![Edit Status window](image)

*Figure 131: Edit Status window*

3. Do one or more of the following:
   - In the Name field, change the status type’s name.
   - In the Image list, choose a new icon.
   - Click the **Completed/Closed** type check box to determine whether giving an item this status closes the item.

4. Click the **OK** button to return to the Manage Status View window.

5. To assign or remove a shortcut for this value, do one of the following:
   - To make the value a shortcut so that users can get to it in the right-click menu, click the **New button** arrow, click **Shortcut**, and select the value from the list that opens, as shown here.

![Add a shortcut for the type.](image)
To delete a shortcut, click the item in the list, and click **Delete shortcut**.

To delete a shortcut, click the item in the list, and click **Delete shortcut**.

You and other users see these changes the next time you log in to TaskMerlin.

To delete an attribute value, take these steps:

1. Click the **Manage** menu, click **Customizable Types**, and select the attribute, such as **Status**.
2. Click the **View full Status list** link.
3. In the window that opens, click the attribute value, and click **Delete**, as shown here.

To delete an attribute value, is to remove that value from the options users have for that attribute. For example, if you delete the value Not Started from the Status attribute, users can no longer use Not Started when assigning a status to an item.
4. In the confirmation window that opens, click **OK**.

5. Click **Close**.

   The value is deleted and users can no longer assign this value to items.

---

**A Project Manager’s Guide to Setting Up Projects**

Assume that you are the project manager for your company’s Web site. You’ve just been given the task of planning the site and building a team to design and test it. Here’s how you can use what you’ve learned in this chapter to set up the project in TaskMerlin.

1. Create a Project item and name it “Corporate Web Site.”
   Don’t forget to set up its start and finish dates. See "Creating an Item" on p. 62 for specifics.

2. Create a Context type called “Corporate.” See "Adding Attribute Values" on p. 90. Then, assign the new Context value to “Corporate,” to let everyone see that this is a project that everyone in the company can use.

3. Set up the project’s folders. Create four Folder items with the Project item as their parent. Name the folders “References,” “People,” “Tasks,” and “Milestones.”

4. In the People folder, create five People items. Tag each one with the role in the project, such as “Web designer,” “QA tester,” “Content writer,” “Project Manager,” and “Stakeholder.”
   These People items represent the people who are involved in the project.

5. In the Tasks folder, create the high-level tasks for this project, such as “Write content,” “Design interface,” “Test site,” and “Generate project reports.”

6. Create a new item type called “Milestone.” The Milestone type can represent the major phases of the project. See "Adding Item Types To TaskMerlin" on p. 85.

7. In the Milestones folder, add the project’s milestones, such as “Phase 1: Design,” “Phase 2: Content development,” and so on.

8. To add TaskMerlin users and their permissions to the project, read "Managing Users and User Permissions" on p. 148, and then read the section "A Project Manager’s Guide to Managing Users and Permissions" on p. 176.
CHAPTER 5: USING THE CALENDAR

The Calendar is the place to schedule your tasks and appointments.

This chapter includes the following topics:
- "About the Calendar," this page
- "Setting Options for the Calendar" on p. 102
- "Integrating Outlook with the Calendar" on p. 107
- "Viewing the Calendar by Day, Week Or Month" on p. 111
- "A Project Manager’s Guide to Using the Calendar" on p. 112

About the Calendar

You can use the Calendar to schedule your work and see your schedule for a day, a week, or a month at a time.

This image shows the Calendar in Week view, plus the buttons and tabs you can use to manage your schedule. The rest of this chapter explains how to schedule items and use these tools.

Scheduling Items on the Calendar

You can schedule an item on the Calendar either when you create it or after you create it. When you schedule the item, you can also set its recurrence or any reminders for it.

This procedure explains how to do this.
To schedule an item on the Calendar, take these steps:

1. Do one of the following:
   - For an existing item, find the item in your folders, open it, and click the **Date** tab in the Edit Item window.
   - For a new item, create the item, and click the **Date** tab.

The Date fields open, as shown here.

![Date fields](image)

**Figure 136: Date fields under Date tab**

**Tip**

You can create an item from the Calendar itself. First, select the cells in the Calendar where you want to schedule the item, right-click, and click the New button.
2. Click the **Start** check box, and select the start date and time in the field that opens.

3. Click the **Finish** check box, and select the task's completion date and time.

4. In the **Deadline** field, type a due date and time.

   If an item has a due date, it appears on the Calendar on that date, regardless of its scheduled start and finish dates.

   Using a deadline also triggers the Overdue By option. With this option, you can see how far overdue an item is in the Item Grid if it wasn’t completed by the due date.

   This image shows the completed Date fields.

![Figure 137: Completed Date fields](image)
5. Click the **Apply** button.

6. To have the item recur, click the **Recurrence** button.

   If you don't see the Recurrence button, you can add it. See "Tailoring the Edit Item Window" on p. 21.

   The Item Recurrence window opens.

   ![Item Recurrence window](image)

   *Figure 138: Item Recurrence window*

   Here you can determine how often the item recurs, and whether the recurrence depends on the item’s Completed status. You can also determine how long the item recurs, and which properties are reset when the item recurs.

7. In the Recurrence pattern section, do one of the following:

   - To make the item recur regularly, regardless of its Completion status, click the **Recur Every** option, and choose the number and **Days, Weeks, Months**, or **Years**. For example, choose 1 Weeks.
   
   - To make the item recur on certain days of the week or month, click **Recur on days of the** and choose **Week** or **Month**. Then set the rest of the fields for this option.

   **Tip** To choose more than one day or month, click the days or months in the lists, one at a time.

   - To link the item’s recurrence to its Completed status, click **Recur on completion after** and choose the number and **Days, Weeks, Months**, or **Years**.
This option makes sure a task doesn’t appear on the Calendar again until a user marks it Complete the previous time.

8. In the Range of recurrence section, choose a start date for the range, and choose a finish date, or leave the No end date option checked.

This image shows completed Recurrence fields. In this example, the item recurs once a month.

Figure 139: Item recurring once monthly
9. Click the **Options** tab.

The Options fields open, as shown here.

![Image of Item Recurrence options](image)

*Figure 140: Item Recurrence options*

Here you can set the item’s behavior once it recurs, how many days it appears on the Calendar ahead of time, and in which folder it recurs. You can also determine what appears in the Summary field on the recurring item.

10. In the Recurring Items Option section, do the following:

- To reset the Status for each instance (from Completed to Not Started, for instance), click the **Reset Status** check box.
- To clear the text in the Content field when the item recurs, click the **Reset Content** check box.
- To clear the Assigned To user, click **Reset Assigned To**.
- To have the item recur on the Calendar before its recurrence date, choose a number from the **Create item days in advance** field.
- To make the recurring item appear in a certain folder, click **Recur in specified folder**, and choose a folder from the list that opens.
11. In the Specify Summary field, type the summary for each recurrence of this item.
   • To add a sequential number to each recurrence, type $SEQUENCE either before or after the summary.
   • To add the recurrence date in the Summary field, type $DATE there too. This image shows how.

![Setting Recurrence options](image)

**Figure 141: Setting Recurring Summary Field options**

12. Click the OK button.
   The Edit Item window appears.

13. To set a reminder for this task, click the Remind Me button, and choose an option from the list.
   To set your own reminder time, click Customize from the list that opens, and choose a date and time.

14. Click the OK button.
   Your item appears on the Calendar on the date and time you specify.

**Setting Options for the Calendar**

You can customize how the Calendar appears by setting the following options:

- Calendar Start and End days of the week
- Working days of the week
- Default folder for items created on the Calendar
- The amount of time each time slot represents (15, 30, or 60 minutes)
- Whether to see completed items in the Calendar
- Which icons to show on each item in the Calendar
■ How reminders work

To set your Calendar options, take these steps:

1. Click the Tools menu, and click Options.

   The Options window opens.

   ![Options window](Figure 142: Options window)

2. Click the Calendar option in the TaskMerlin User list.

   The Calendar fields open, as shown here.

   ![Calendar field options](Figure 143: Calendar field options)

3. In the first list, choose a default folder for items you create on the Calendar itself.

   This folder contains any items you schedule that you don’t assign to other folders.
4. To see items whose status is Completed within the Calendar, make sure the Show completed items within the calendar check box is checked.

5. To see the week number for the year in the Month grid, click Show week numbers in Month grid. This image shows how that looks.

![Figure 144: Numbers of week in the Month view of the Calendar](image)

6. In the Show images for section, click the check boxes for the icons you want to see on each item in the Calendar. This image shows an item with Reminder, Recurrence, and Assigned To icons.

![Figure 145: Icons on a Calendar Item](image)

7. Click Apply. Your changes appear in the Calendar immediately.
8. To set up how reminders work, click **Reminders** under TaskMerlin User. The Reminders fields open.

![Click Reminders to open the Reminders fields.](image)

**Figure 146: Reminders options**

9. In these fields, do the following:
   - Set the snooze time and the morning start time.
   - Set up whether to receive pop-ups and what TaskMerlin does with pop-ups.
   - Choose a program to run with the reminder.

10. Click **OK**.

Your changes to the Calendar options take effect immediately.

11. Click **Database**, and click **Schedule** in the list that opens.

The Schedule fields open.

![Click Schedule to open the Schedule fields.](image)

**Figure 147: Calendar Schedule options**
12. In the First Day of the Week list, choose the day of the week that you see on the left side of the Calendar. For example, choose Sunday.

13. In the First Work Day list, choose your first workday of the week, such as Monday.

14. In the Last work day list, choose the last workday of your week, such as Friday.

When you designate your workweek with these days, days not in this range appear dimmed in the Calendar. However, you can still schedule items on these days.

For example, in the following image, the user has chosen the workdays of Monday through Friday, but a First day of the week of Sunday. So the Calendar in Week view begins on Sunday, but Sunday and Saturday are dimmed because they are not designated as workdays.

![Calendar Showing Working and Non-Working Days](image)

Figure 148: Calendar Showing Working and Non-Working Days

15. In the Time Scale list, choose the amount of time each cell represents. You can choose a range from 5 minutes to 60 minutes.

The Calendar in the above image uses a range of 30 minutes, so each cell represents a 30-minute block of time.

16. In the Work start time and Work end time fields, set the length of your workday.

Hours beyond this time frame appear dim. However, you can still schedule items here.

17. In the Default time unit list, choose **Minutes, Hours, Days, Weeks, Months, Years, or Units.**

What you choose here appears by default when you select a Time field, such as Time Estimated.
18. In the Units value list, choose a value. This value applies if you choose a default time unit of units.

19. Click **Apply**, and click **OK** to close the Options window.

### Integrating Outlook with the Calendar

You can make sure your TaskMerlin calendar and your Outlook calendar show the same schedule by copying items from one calendar to the other.

Integrating Outlook with the Calendar includes these processes:

- "Configuring Outlook in TaskMerlin" on p. 107
- "Copying Items From Outlook to TaskMerlin" on p. 108
- "Copying Items from TaskMerlin to Outlook" on p. 110

#### Configuring Outlook in TaskMerlin

To configure Outlook for TaskMerlin’s Calendar is to determine how TaskMerlin handles linking between Outlook and TaskMerlin for items and attachments. It also includes setting up notices for changes in either calendar.

To configure your Outlook settings, take these steps:

1. Click the **Tools** menu, and click **Options**.

   The Options window opens, as shown here.

   ![Figure 149: Options Window](image)
2. Click the plus sign next to Database to expand the list, and click **Outlook**. The Outlook fields open, as shown here.

![Figure 150: Outlook options](image)

3. To include a hyperlink to the item in Outlook in the Content area of the item, make sure **Create hyperlinks for Outlook items** is selected.

4. To allow hyperlinks to attachments in items copied from Outlook, make sure the **Create hyperlinks for Outlook item attachments** check box is selected, and select a folder for storing the attachments from Attachment Folder field.

5. To receive a notice every time you are about to add an item to Outlook’s To Do List or Calendar, make sure the **Prompt before adding item to the Outlook To-Do List or Calendar** check box is selected.

6. To receive a notice every time you copy an Outlook item to a cell other than its original time, make sure the **Prompt to move pasted items to the selected Calendar cell** is checked.

7. Click **OK**.

---

### Copying Items From Outlook to TaskMerlin

You can copy and paste items between Outlook and TaskMerlin by using either drag-and-drop, or by using the **Ctrl-C** and **Ctrl-V** commands. If you use the commands, you can copy the item to a different date and time than its original Outlook date and time.

The procedures in this section explains how to use either method.

- **To drag and drop items from Outlook to TaskMerlin, take these steps:**

  1. Make sure TaskMerlin is open.
2. Open Outlook, and go to the Outlook Calendar.

3. Find the item in the calendar you want to copy, and click and drag it to the TaskMerlin calendar.

![Find the appointment in Outlook.](image)

![New item brought over from Outlook in the Items list.](image)

**Figure 151: Dragging an item from Outlook to TaskMerlin**

The item appears on the Calendar and in the Items list, as shown here.

![New item brought over from Outlook in the Items list.](image)

**Figure 152: Calendar Items List**

---

**Caution**

If the item on your Outlook calendar changes, you must copy the item again or manually change the properties in the TaskMerlin calendar.

To copy and paste items from Outlook to TaskMerlin, take these steps:

1. Make sure TaskMerlin is open.
2. Open Outlook, and go to the Outlook calendar.
3. Find the item you want to copy in the calendar.
4. Click the item and press **Ctrl+C**.
5. To copy the item to a new time slot in TaskMerlin, click the cell in the Task-Merlin calendar, and press **Ctrl+V**.
6. In the confirmation window that opens, click **OK**.
   This window appears depending on how you’ve configured Outlook in your Options window.
   The item appears on your calendar in the time slot you selected.
7. To paste the item to the Calendar using the item’s Outlook date and time, press **Ctrl+V**.
   The item appears in the TaskMerlin Calendar and items list.

### Copying Items
from
TaskMerlin
to
Outlook

If you create and schedule an item in TaskMerlin, you can move it over to Outlook to keep both calendars current.

This procedure explains how.

**To copy an item from TaskMerlin to Outlook, take these steps:**

1. Find the item in your TaskMerlin calendar.
2. Right-click the item, and select **Add to Outlook Calendar**. This image shows how.

![Figure 153: Selecting the Item to Copy to Outlook](image)

3. In the confirmation window that opens, click **OK**.
   The item appears on your Outlook calendar.

**Caution**

If you update the item in either TaskMerlin or Outlook, you must update the item on the other Calendar manually.
Viewing the Calendar by Day, Week Or Month

When working in TaskMerlin, you can see your Calendar by day, week, or month. In this way, you can override your Calendar options settings if you need to.

To change the Calendar view, take these steps:

1. Click the Calendar tab to see the Calendar.
2. To use the Month View tab, click the Month View tab on the left side of the Calendar, and select the period you want to see.

![Figure 154: Selecting days to see in the Month View pane]

The dates you select appear in the Calendar pane, as shown here.

![Figure 155: Selected days on the Calendar]
3. Use the navigation buttons above the Calendar pane to move through the Calendar.
   For example, click the **View time period** button.
   This image shows how.

   ![Navigation buttons in the Calendar pane](image)

   **Figure 156: Navigation buttons in the Calendar pane**

**A Project Manager’s Guide to Using the Calendar**

1. Schedule the milestones and tasks you set up in the previous chapter. See "Scheduling Items on the Calendar" on p. 96.
2. Set up your preference for the Calendar’s appearance. See "Setting Options for the Calendar" on p. 102.
4. Use the Calendar navigation tools (the Month View tab and the navigation buttons) to work through the project’s schedule. "Viewing the Calendar by Day, Week Or Month" on p. 111.
CHAPTER 6: USING THE GANTT CHART

This chapter covers the following:
- "About the Gantt Chart" on p. 114
- "Navigating the Gantt Chart" on p. 114
- "Scheduling Items and Setting Dependencies on the Gantt Chart" on p. 117
- "A Project Manager's Guide to Using the Gantt Chart" on p. 121

About the Gantt Chart

A Gantt Chart is a type of bar graph that illustrates a project’s schedule. By capturing the start and end dates of tasks within a project, the Gantt Chart shows the work breakdown structure (WBS) of the project. TaskMerlin Professional Edition provides a Gantt Chart you can use to track your projects.

Navigating the Gantt Chart

Any item you create appears in the Gantt Chart, depending on your settings for the Gantt Chart pane. This section explains how to move around the Gantt Chart pane.

To navigate the Gantt Chart, take these steps:

1. To open the Gantt Chart, click the Gantt Chart tab.
   
   If you don’t see the Gantt Chart tab, make sure you are using the Professional Edition of TaskMerlin. If you are, click the View menu, and click Gantt Chart to open it.
   
   The Gantt Chart opens, as shown here.

![Gantt Chart Image]

By default, the Gantt Chart shows all items, but items without scheduled dates don't have task bars in the chart.
2. To see items by their date properties, click the **Show by date** button in the tool bar.

![Show by date button](image)

*Figure 158: Show items by date*

3. Do one of the following:
   - To see items with a Start date, Finish date, or Duration, click **Show only items with a Start, Finish, or Duration**.
     Items with none of these properties disappear from the Gantt Chart.
   - To see items with Start or Finish dates but without Duration, click **Show only items with a Start or Finish**.
     Items with or without Duration and without either a Start or Finish date disappear from the Gantt Chart.
   - To see all your items in the Gantt Chart, click **Show any item**.
     The Gantt Chart shows all items regardless of date or Duration settings.

4. To see the Gantt Chart by a time period of days, weeks, or months, click the **Change time line** button on the tool bar, and click **Days**, **Weeks**, or **Months**, as shown here.

![Change time line button](image)

*Figure 159: Change time line button*

The Gantt Chart shows the time line by the period you’ve chosen.
Using the Gantt Chart

5. To select specific dates for the Gantt Chart, select the date range in the Month View tab.
   To see dates for the selected item and its sub-tasks only, press the Ctrl+L keys as you select dates in the Month View tab.

6. To see items scheduled for a relative time period, such as today or this week, click the View time period button on the tool bar and click Today, This Week, This Fortnight, or This Month, as shown here.
7. To see only items in one folder, click the folder in the Folders list.

8. To see items using a filter, click the **Filters** button in the tool bar, and click the filter you want, as shown here.

![Figure 162: Filtering items in the Gantt Chart](image)

9. To highlight items with an impact of Critical, click the **Show Critical Items** button.

The Gantt Chart highlights items in the critical path through the project with a red task bar.

![Figure 163: Critical items in the Gantt Chart](image)

**Scheduling Items and Setting Dependencies on the Gantt Chart**

This section includes the following topics:
- "Managing Schedules in the Gantt Chart," this page
“Setting Item Dependencies” on p. 119

An item’s Start date, Finish date, and duration determine where items appear in the Gantt Chart. You can add or change these dates by opening and editing the item, which is explained in "Opening and Editing an Item" on p. 71. This section however, explains how to do the following within the Gantt Chart itself:

- Change the item’s start and end dates at the same time.
- Change the duration.
- Change the item’s progress.
- Schedule items and change the dates or duration in the Gantt Chart, without opening the item.

To schedule items in the Gantt Chart, take these steps:

1. To open the Gantt Chart, click the Gantt Chart tab and find the item.

   **Tip** If you don’t see an item in Gantt Chart because its dates are out of view, press Ctrl and click the Item in the list of items.

2. To change the item’s start and end dates, click and drag the item’s task bar to the new date range, as shown here.

   ![Figure 164: Click and drag the entire task bar to change the date range](image_url)
3. To change the item’s duration, click and drag the right side of the task bar, as shown here.

![Figure 165: Drag the right side of the task bar to change the duration](image)

Figure 165: Drag the right side of the task bar to change the duration

4. To change the item’s progress, click and drag within the item’s task bar. The task bar shows blue in the task bar, as shown here.

![Figure 166: Click and drag within the task bar to change the progress](image)

Figure 166: Click and drag within the task bar to change the progress

### Setting Item Dependencies

A dependency is a connection between tasks. Usually, a dependency indicates that work on one task (the predecessor) must finish before work on the next task (the successor) can start.

In a Gantt Chart, an arrow between dependent tasks connects them.
To create a dependency, you link a task to a preceding task. You can do this when you create the item, but you can also do it in the Gantt Chart itself. This section explains how.

Before you begin, make sure both tasks are not designated folders. Folder items, such as projects, cannot be linked to any items in the Gantt Chart.

To create a dependency between tasks, take these steps:

1. In the Gantt Chart, select the first item. This item acts as a predecessor to another item.
2. In the tool bar, click the **Link selected item to successor** button, as shown here.
3. Click the item you want to link the first item to.
   In the Gantt Chart, an arrow shows the dependency between items, as shown here.

4. To remove the dependency and unlink the items, click the second item, click the **Link item to successor** button, and click **Unlink predecessor from selected item**.
   The arrow between the items disappears.

**A Project Manager’s Guide to Using the Gantt Chart**

The Gantt Chart is a key component of managing your projects in TaskMerlin. It provides a big-picture view of a project’s progress. Now that you’ve set up the project “Corporate Web Site,” you can schedule its tasks in the Gantt Chart.

Here is your roadmap for setting up and using the Gantt Chart for your project.

1. Create tasks and projects with Start and Finish dates and deadlines so you can track them in the Gantt Chart.
2. Track a project's progress, deadlines, and dependencies in the Gantt Chart.
3. Update tasks’ dates and deadlines in the Gantt Chart.
CHAPTER 7: MANAGING PROJECT DOCUMENTS

This chapter includes the following topics:
- "About Documents," this page
- "Using Quick Notes to Capture Information" on p. 122
- "Adding Documents to Items" on p. 126
- "E-mailing Items" on p. 132
- "Importing Items" on p. 133
- "Exporting Items" on p. 135
- "A Project Manager’s Guide to Managing Documents" on p. 137

About Documents

A document is any file, such as a Word or Power Point file, you can add to TaskMerlin. You can either import and embed these files a OLE objects, or you can link to their location from TaskMerlin.

Another type of document is a Quick Note, which is a TaskMerlin item you can use for jotting outside of an item. You can later save the notes as an item or create items from these notes.

A third type of document is the TaskMerlin item itself.

This chapter explains how to add, manage, and e-mail all types of documents in TaskMerlin.

Using Quick Notes to Capture Information

Quick Notes is a way to add information to TaskMerlin before you create an item for it. You can use Quick Notes to take meeting minutes, for example, and then later store the minutes as part of a project. You can even create items from Quick Notes text as you write.

Before using Quick Notes, you can set up how Quick Notes works in your workspace, which is explained next.

Setting Up Quick Notes

To set up Quick Notes to is determine how Quick Notes behaves in your workspace. You can determine the following:
- Whether you see the Quick Notes window when you open TaskMerlin
- Whether you keep the Quick Notes window on top of all other windows, including windows outside of TaskMerlin as you work
- Whether you see the first blank space in Quick Notes when you open it
To set up Quick Notes, take these steps:

1. Click the **Quick Notes** button above the Folders list, as shown here.

![Click the Quick Notes button.](image)

*Figure 169: Quick Notes button*

The Quick Notes window opens.

2. In the Quick Notes window, click the **Options** button. This image shows how.

![Click the Options button.](image)

*Figure 170: Options button*
3. In the Options window that opens, do one or more of the following:
   • Select **Display the Quick Notes window on login**.
   • Select **Display the Quick Notes window above all other windows**.
   • Select **Scroll to the end when opened**.

   This image shows the Quick Notes Options window.

![Figure 171: Setting options for Quick Notes](image)

4. Click **OK** to save your changes.

   The Options window closes. See the next section to learn how to use Quick Notes.

**Using Quick Notes**

When you use Quick Notes, you can save your notes in Quick Notes, but you cannot save several versions of Quick Notes. For best results, use Quick Notes to capture information without opening an item, and then create items to categorize and store the information.

This procedure explains how.
To use Quick Notes, take these steps:

1. Click the **Quick Notes** button above the Folders list, as shown here.

![Quick Notes window with Notes](image)

The Quick Notes window opens.

Here you can enter notes or take meeting minutes before saving the information in your TaskMerlin files.

2. Type your notes.

   You can change the font size, color, or type, and format the text in other ways using the tool bar at the top, as this image shows.

![Quick Notes window with Notes](image)
3. To save your notes without closing the window, click **Apply**, and go to the next step. Otherwise, go to step 7.

4. To create items from your Quick Notes, select the text, right-click, and choose **Create Items**.

   This image shows how.

   ![Creating an item from Quick Notes text](image)

   **Figure 174: Creating an item from Quick Notes text**

5. To see the new item now, open the Inbox.

   The item Summary (title) is the same as the text you selected.

   This image shows the new item in the Item Grid.

   ![New item in the Inbox](image)

   **Figure 175: New item from Quick Notes in the Inbox folder**

You can continue to write in the Quick Notes or close it to move on to other things.

6. To clear the Quick Notes window, click **Clear**.

7. To save your notes and close the window, click **OK**.

**Adding Documents to Items**

You can add external documents, such as Word files, to items by either embedding them or linking to them. You can create the document as you add it, or add
an existing document. The procedures in this section explain how to do the following:

- Create and add a document to TaskMerlin at the same time.
- Embed or link an existing document to TaskMerlin.
- Hyperlink a TaskMerlin item to an existing document or another item.

**Tip**
The applications on your system determine the type of documents you can create and add to TaskMerlin. For example, if you do not have a mind-mapping application, you cannot add a mind-mapping document to TaskMerlin.

---

**Creating and Adding Documents to TaskMerlin**

If you need to create a document at the same time you add it to TaskMerlin, you can do so by embedding the document as you create it. If you want to link a document instead of embedding it, it is best to create the document first and then embed it. See "Linking or Embedding Existing Documents" on p. 128 for instructions.

1. To create a document and add it to an item, take these steps:
   1. Open the item in TaskMerlin.
   2. In the Content pane, right click, and select **Insert Object**.
      
      The Insert Object window opens, as shown here.

      ![Insert Object window](image)

      *Figure 176: Insert Object window*
3. Click **Create New**.
4. In the Object Type list, select the document type, such as Bitmap image.
5. To see an icon of the document in the Contents pane, click **Display as icon**. This image shows how.

![Display As Icon option](image)

*Figure 177: Display As Icon check box*

**Tip** You can change the icon by clicking Change icon and choosing a new image.

6. Click **OK**.

The document appears as text or an image in the Contents pane of the item.

**Linking or Embedding Existing Documents**

You can add existing documents from your computer to TaskMerlin by either linking to them or embedding them in the item.

To link to a document is to create a shortcut to the document from within the TaskMerlin item. If you must store the document outside of TaskMerlin and you update it periodicals, linking is the best option, because the link always points to the current version of the document.

To embed the document is to copy the document into TaskMerlin. This is the best option if you do not need to store a copy on your computer or if the document does not require updating.

- To either link or embed an existing document, take these steps:
  1. Open the item in TaskMerlin.
2. In the Content pane, right-click, and select **Insert Object**. The Insert Object window opens, as shown here.

![Insert Object window](image)

*Figure 178: Insert Object window*

3. Click the **Browse** button and navigate to the document.

   The path with the document name appears in the File field of the Insert Object text box, as this image shows.

![Path to document in Insert Object text box](image)

*Figure 179: Path to document in Insert Object text box*

4. To create a shortcut to the document only, click the **Link** check box.

   To embed the document, leave the Link check box clear.

5. To show an icon, instead of text only, of the document type in the item, click the **Display as icon** check box.

   Otherwise, leave this check box un-checked.

| Tip   | You can change the icon by clicking Change icon and choosing a new image. |
6. Click **OK**.

An image or text label of the document appears in the Content pane of the item, as this image shows.

![Image of document in Content pane of item](image.png)

**Figure 180: Image of document in Content pane of item**

Instead of embedding or linking documents in items, you can create a hyperlink from text in the item to the document itself. You can also hyperlink items to other items. This section explains how.

To hyperlink items to items or to external documents, take these steps:

1. Open the item to create the hyperlink from.
2. In the Content pane, select the text to use as the hyperlink, and click the blue **H** button in the tool bar.

This image shows how.

![Select the text and click the H (Hyperlink) button in the tool bar](image.png)
Figure 181: Selecting text to hyperlink

The New Hyperlink window opens, as shown here.

Figure 182: New Hyperlink window

3. In the Hyperlink description field, change the name of the hyperlink if you need to.

4. Do one of the following:
   - To link to a document outside of TaskMerlin, click the Address option, click the Folder icon, and navigate to the document on your computer.
   - To link to another TaskMerlin item, click the Item option, and navigate to the item in the list that opens.

This image shows how.

Figure 183: Linking text to another item
5. Click **OK**.

The new link appears in the Content pane, as this image shows.

![New hyperlink in Content pane](image)

**Figure 184: New hyperlink in Content pane**

### E-mailing Items

You can e-mail items to any TaskMerlin user as long your user account includes permissions for e-mailing. The users you send items to must have user accounts, but they don't have to be active users. For example, if you want to e-mail a project stakeholder who does not use TaskMerlin, you can set up an account for the stakeholder with a login status of No Login. The stakeholder can receive e-mails but cannot access TaskMerlin. Setting up users and e-mail is explained in "Managing Users and User Permissions" on p. 148.

This procedure explains how to e-mail items.

- **To e-mail an item, take these steps:**
  1. Find the item in the Item Grid.
2. Right click the item and select **E-mail item**.
   The New Message window opens, as shown here.

![New Message window](image)

**Figure 185: New Message window**

3. In the From field, select a user.
4. In the To field, choose a user.
   You cannot send this item to someone who is not set up as a TaskMerlin user.
5. In the CC field, choose a user to include in the message.
6. In the Subject and Message fields, add or edit the existing text.
7. To attach the item as a separate document, make sure the Attach item check box is selected.
8. Click **Send**.
   The message is sent to the user.

**Importing Items**

You can import information from either another TaskMerlin database or from an external document, such as an Excel file. This section explains both options.

- To import items from another TaskMerlin database, take these steps:
  1. Open the database you want to import items from.
  2. Show all the items you want to import in the Item Grid.
  3. Select all items in the Item Grid, and press **Ctrl+C**.
  4. Open the database to import the items to.
  5. Click in the Item Grid, and press **Ctrl+V**.
   The items are copied to the new database.
To import items from external files, take these steps:

1. Open the spreadsheet and copy and paste the first two columns to the clipboard.

**Tip** You can import two columns from the clipboard. For best results, title the columns Summary and Content.

2. Click the **File** menu, and click **Import and Export**.
   The Import/Export window opens.

   ![Import/Export window](image)

   **Figure 186: Import/Export window**

3. In the list, click **Import Items**, and click **OK**.
   The Import Items window opens, as shown here.

   ![Import Items window](image)

   **Figure 187: Import Items window**
4. In the Parent list, choose a folder to hold the items.
5. In the ColumnDelimiter list, choose Tab, Comma, or Vertical Bar.
6. Click Insert rows from clipboard.
7. To enter items by hand, click Insert new row and type the information in the Summary and Content fields of the rows that appear.
8. Click Import.

The items appear the Item Grid in the Parent folder you selected.

Figure 188: Items imported from the clipboard

Exporting Items

To export items to another TaskMerlin database, you can copy and paste the items between the databases. See p. 133 for instructions.

To export items from a TaskMerlin database to the clipboard or a .TXT file (so you can import them into an external file later), use the procedure in this section.

To export items, take these steps:
1. Make sure the items you want to export appear in the Item Grid.
2. Click the File menu, and click Import and Export.

The Import/Export window opens.

Figure 189: Import/Export window
3. Click **Export Items**, and click **OK**.

   The Export Items window opens, as shown here.

   ![](image1.png)

   **Figure 190: Export Items window**

4. In the Parent Folder list, choose the items’ parent folder.

5. In the Column Delimiter field, choose **Tab**, **Comma**, or **Vertical Bar**.
   - Use Tab to break columns by tab stroke.
   - Use Comma to break columns at each comma.
   - Use Vertical Bar to break columns at each vertical bar.

   This image shows how.

   ![](image2.png)

   **Figure 191: Choosing a column delimiter**

**Tip** If you later import the items into Excel or another file, make sure to choose the same option as the column delimiter.
6. In the Row Delimiter section, click **CR/LF, Comma, or Vertical Bar**.
   - Use CR/LF to break rows by the carriage return/line feed at the end of a row.
   - Use Comma to break rows when the importing application encounters a comma.
   - Use Vertical bar to break rows at every vertical bar.

![Choose the row delimiter](image)

7. To include quotes around each value in each cell, select **Quote columns**.
8. To include the column headers, select **Include header**.
9. In the Copy section, do one of the following:
   - Click **Item Grid columns** to copy only the columns in the Item Grid.
   - Click **All columns** to copy all available columns.
10. Do one of the following:
    - To copy the items to your computer's clipboard, click **Copy items to the clipboard**.
      Use this option if you plan to paste the items in an Excel spreadsheet or other non-text file, or if you plan to import them into a different TaskMerlin database.
    - To create a text file of these items, click **Save items to file**, and use the Save As window that opens to save the file to your computer.
11. Click **Close**.
   
   See "Importing Items" on p. 133 for importing instructions.

A Project Manager’s Guide to Managing Documents

As a project manager, you can use TaskMerlin's document management features to capture and control your project's documentation. Here are some examples:

- Send users e-mails with their tasks when you want them to see them.
- Connect TaskMerlin items to Word, Excel and other files by either linking or embedding the files. Give access to users who need to see them.
- Import items from other TaskMerlin databases or the clipboard and manage them in TaskMerlin.
- Export items to Word, Excel or other files, or to another TaskMerlin database.
CHAPTER 8: REPORTING AND PRINTING

This chapter explains the following:

- "Creating Custom Reports," this page
- "Printing Items and Lists of Items" on p. 141
- "Printing Folders and Their Contents" on p. 143
- "A Project Manager's Guide to Reporting and Printing" on p. 146

Creating Custom Reports

To create a custom report is to set up a filter that shows only the items with properties you want in the report. You can then print the item grid.

You can print a filter's items to a file if you prefer.

To create and print a custom report, take these steps:

1. Create the filter, if you haven't already done so. See "Navigating Items Using Filters" on p. 33 for instructions.
2. In the Filters pane, right-click the filter, click Print, and click Item Grid, as shown here.

3. In the Print window that opens, set up any printing preferences, and click OK.
4. To print the Item Grid to a file, do this:
   a. Right-click the filter and click Print.
b In the Print window that opens, click Print to File, and click OK. This image shows how.

![Print window](image)

Figure 194: Print window

c Click OK.

d In the Print to File window that opens, type the file’s name, as shown here.

![Print to File window](image)

Figure 195: Type the file's name

e Click OK.

Any files you print are stored in the TaskMerlin program directory.

**Printing Items and Lists of Items**

By printing items, calendars, and folders, you can print:

- A list of items in the Item Grid
- An individual item and its details

You can print all of the above as hard copies or to electronic files on your computer.

**Tip**

In these procedures, you can see what will print before you print. To do so, click Print Preview instead of Print and select what you want to print. A window opens showing the contents to be printed.

**Printing Items in the Item Grid**

To print the items in the Item Grid is to print a list of the items in the current grid. All the columns in the grid are printed, too, in the order the items are sorted at that time.
This image shows a sample of a printed Item Grid.

![Sample Item Grid](image1)

**Figure 196: Sample Item Grid**

To print items in the Item Grid, take these steps:

1. Make sure the items are listed in the current Item Grid.
2. Do one of the following:
   - Click the **File** menu, click **Print**, and click **Item Grid**.
   - Right-click in the Item Grid and click **Print**, and click **Item Grid**.

**Tip**

To see what will print before you print it, click Print Preview instead of Print and select Item Grid. A window opens showing the contents to be printed.

3. In the Print window that opens, set your preferences, and click **OK**
   
The items are printed as they appear in the Item Grid.

**Printing Item Details**

To print an item’s details is to print the item’s information and its contents. The item’s information includes any attributes set about the item, such as Status, Time Spent, and so on.

This image shows a preview of a printed item.

![Sample printed item](image2)

**Figure 197: Sample printed item**
To print an item’s details, take these steps:

1. Right-click the item in the Item Grid.
2. In the shortcut menu that opens, click Print, and click Item.
3. In the Print window that opens, set your preferences, and click Print.

The Item and its details are printed.

**Printing Folders and Their Contents**

This section explains how to print the following:

- A outline of your folders
- A list of folders and the folders’ Item Grid
- A list of folders and the details of the items in them

A folder is any item in the Folders list that is marked as a folder. If an item appears in the item list and is marked as a folder, even if it is not a Folder item type, you can print it using the following procedures.

You can print a list of all your folders in your database or just the folders within a specific folder.

**Tip**

In this procedure, you can see what will print before you print it. To do so, click Print Preview instead of Print and select what you want to print. A window opens showing the contents to be printed.

**Printing Folder Outlines**

To print a folder outline is to print a list of all folders in the default Projects folder.

This image shows a sample of a printed folder outline.

![Sample printed folder outline](image)

*Figure 198: Sample printed folder outline*
To print an outline of your folders, take these steps:

1. Click the **File** menu, click **Print**, click **Folders**, and click **Outline**, as shown here.

![Figure 199: Printing the Folder outline](image)

2. In the Print window that opens, set your preferences, and click **OK**. The folder outline is sent to the printer.

You can print a folder and its items in the Item Grid format. The items in the Item Grid become a list of all items in that folder. This image shows a preview of the folder and the Item Grid in this format.

![Figure 200: Sample folders with Item Grid](image)
To print a folder and the Item Grid, take these steps:

1. Do one of the following:
   - To print a specific folder and a list of its items, right-click the folder, click **Print**, click **Folders**, and click **Folders and Item Grid**. Go to step 2.
   - (Professional version only) To print the list to an HTML file, click **Folders and Item Grid (HTML)**, and type the name in the window that opens.
   - To print all folders in the Project folder and the Item Grid, click the **File** menu, click **Print**, click **Folders**, and click **Folders and Item Grid**. Go to step 2.

2. In the Print window that opens, set your preferences, and click **OK**.
   The folders and item list are sent to the printer.

Printing Folders and Item Details

You can print a folder and the details of each item in it.

This image shows a preview of a folder with its item details.

![Sample printed folder with item details](image)

**Figure 201: Sample printed folder with item details**

To print a folder and the item details, take these steps:

1. Do one of the following:
   - To print a specific folder and its items, right-click the folder, click **Print**, click **Folders**, and click **Folders and Items**. Go to step 2.
   - To print all folders in the Project folder and all the items, click the **File** menu, click **Print**, click **Folders**, and click **Folders and Items**. Go to step 2.

2. In the Print window that opens, set your preferences, and click **OK**.
   The folders and the details of the items are sent to the printer.
A Project Manager’s Guide to Reporting and Printing

Here are some ideas for creating reports and printing information about your project.

- To take a “snapshot” of the project and store it offline as a summary report, creating a filter showing important information about items, such as status, time spent, or item progress, and print the file as a hard copy or to a file.
- Send a summary report to project stakeholders to let them know how the project is progressing.
- To see how well organized your TaskMerlin files are and look for ways to improve the structure, print an outline of the project’s folder structure to analyze.
A user is anyone who uses TaskMerlin to manage his or her projects and tasks. Users can have different levels of permissions, but only users who are assigned the role of Administrator can manage other users and their permissions.

This chapter describes how to manage users and their permissions. It is for TaskMerlin Administrators only. It includes the following sections:

- "Collaborating with Coworkers," this page
- "Managing Users (Personal and Professional Editions)," this page
- "Managing Permission Templates (Professional Edition Only)" on p. 160
- "A Project Manager’s Guide to Managing Users and Permissions" on p. 176

Collaborating with Coworkers

If you collaborate with coworkers on projects, you can use TaskMerlin to manage tasks and share documents with these coworkers. Once you set up each person on the project as a TaskMerlin user, you each can access the project’s information in the TaskMerlin database. One user can act as the project manager who oversees the tasks and documents for other users.

Here’s how such collaboration can work.

![Figure 202: Collaboration with TaskMerlin](image)

The rest of this chapter explains how to set up and manage users for both collaboration and individual use.

Managing Users (Personal and Professional Editions)

Users are people who use TaskMerlin to manage their projects and tasks. As an administrator, you can add users, edit their permissions, and delete or disable their accounts. The procedures in this section explain how.
Adding Users

To add a user is to create an account for the user so the user can log in and manage projects and tasks. When adding a user, you can do the following:

- Add the user’s name, login ID, and password.
- Assign the user to a default permissions template.
- Set up the user’s e-mail capabilities.
- Customize how the user sees the TaskMerlin workspace.

To add a user, take these steps:

1. Click the Manage menu, and click All User Profiles.
   The Manage User Profiles window opens, as shown here.

   ![Manage User Profiles window](image)

   *Figure 203: Manage User Profiles window*

2. Click the New button.
   The New User Profile window opens, as shown here.

   ![New User Profile window](image)

   *Figure 204: New User Profile window*
3. In the General tab, do the following:
   - In the User Name field, type the user's login name.
   - In the Image list, choose an image to represent the user.
   - In the Full Name field, type the user’s first and last names.
   - In the E-mail field, type the user’s e-mail address.
   - To allow this user to log in, make sure the Enabled check box is checked.
   - To set up the TaskMerlin workspace for the user, click the **Options** link and edit the user’s options in the window that opens.

   This image shows how to complete these fields.

![Figure 205: Completed General tab for a new user](image)

4. Click the **Password** tab, and do one of the following:
   - To give the user a password, click **Change Password**, and type a password in the field that appears. This password cannot contain spaces.
   - To let the user log in without a password, leave the Change Password check box unchecked.

   This image shows how.

![Figure 206: New user’s password](image)
5. Click the **Login Type** tab, and do one of the following:
   - To prevent the user from logging in, click **No login**.
   - To make the user an Administrator, click **Administrative login**.
   - To make the user a user with selected permissions, click **User login (with selected permissions)**, and select the permission template in the list.

**Note**
For more about Permission templates, see p. 160.

This image shows how to complete these fields.

![Figure 207: User login information: Selecting a permission template](image1)

6. Click the **Miscellaneous** tab, and do the following:
   - To allow the user to own items, make sure the **Can own items** check box is checked.
   - To allow the user to be assigned items, make sure the **Can be assigned items** check box is checked.

This image shows how.

![Figure 208: User item permissions](image2)
7. Click the **OK** button.
   The user’s information appears in the Manage User Profiles window, as shown here.

![New user appears in list of users](image)

*Figure 209: New user in Manage User Profiles window*

8. Do one of the following:
   - If you are finished adding users, click the **Close** button.
   - To add another user, return to the first step of this procedure.

### Replicating Users’ Configurations

You can copy one user’s account settings and permissions to other users in one step if you replicate the user's account. Before you begin, make sure the destination user or users are logged out. Also, make sure each user has an enabled login type.

When you replicate a user, the user’s settings you can copy to other user accounts are:

- Columns
- Options
- Custom type view (Shortcuts)
- Item Editor window fields
- Preview Details fields
To replicate a user’s account settings, take these steps:

1. Click the Manage menu, and click All User Profiles.
   The Manage User Profiles window opens, as shown here.

   ![Figure 210: Manage User Profiles window](image)

2. Click the Replicate Configuration button.
   The Replicate User Configuration window opens.

   ![Figure 211: Replicate User Configuration window](image)
3. In the Source login user list, select the user whose settings you want to copy.
4. In the Destination login users list, select the users you want to copy the settings to.
5. In the Configuration items list, select the settings to copy.
   - Click **Grid Columns** to copy the user’s Item Grid layout.
   - Click **Preview Fields** to copy the user’s Preview Details fields and layout.
   - Click **Editor Fields** to copy the fields the user has in the Edit Item window.
   - Click **Options** to copy the user’s personal settings. These are the settings users see in the Options window under TaskMerlin User.
6. In the Custom Type Views section, click the shortcuts you want to copy.
   Users see these shortcuts in their right-click menu when working with items.
   This image shows some options for these settings.

   ![Options to copy to other user accounts](image)

   *Figure 212: Replicating user settings*

7. Click the **Replicate** button.
   The user’s settings are copied to the destination users.
8. In the confirmation window that opens, click **OK**.

   ![Confirmation window](image)

   *Figure 213: Confirmation window*

9. When the Replication complete message appears, click **OK**.
   The next time these users login, they have the settings you copied to them.
10. Click **Close** to close the Replicate User Configuration window.

Once a user is in the system, you can see a summary of the user's activity or change the user's account by doing the following:

- Enabling or disabling the account, which determines whether the user can access TaskMerlin. A user who is disabled cannot log in and cannot have items such as tasks assigned to her.
- Removing the user's login name from the list of user login names, which means the user cannot log in but can still be assigned tasks.
- Changing the user's permissions (at either the account or the permissions-template level)
- Changing what the user sees in the workspace
- Resetting the user's password

To see or change the user's account information, take these steps:

1. Click the **Manage** menu, and click **All User Profiles**.
   
The Manage User Profiles window opens, as shown here.

![Figure 214: Manage User Profiles window](image)

2. Find the user in the list.

   To narrow the list, click the **Filter** list, and choose one of the following:
   
   - Select **Regular, enabled users** to see only users whose login status is enabled.
   - Select **Regular users** to see all users regardless of login status.
   - Select **Predefined users** to see only the built-in users, such as Administrator.
   - Select **All Users** to see both predefined and added users.
3. To see a summary of the user’s activity, select the user and click the **Summary** button.

The Summary Information window opens, as shown here.

![Figure 215: User summary information](image)

4. To close the window, click **OK**.

5. To change the user's information, select the user and click the **Edit** button.

The Edit User Profile window opens, as shown here.

![Figure 216: Edit User Profile window](image)
6. To disable or enable the user account, click the **Enabled** check box.

7. To change the user's login name, image, or E-mail address, update the fields in the General tab, as shown here.

   ![Figure 217: Updating a user's name, image, or e-mail address](image)

8. To change the properties of the user's TaskMerlin workspace, click the **Options** button and make the changes in the window that opens.

9. To change or add the user's password, click the **Password** tab and update the Password field, as shown here.

   ![Figure 218: Updating a user's password](image)
10. To change the user’s login status or permissions, click the **Login** tab, and use the options to change these properties, as shown here.

![Figure 219: Updating a user's login status](image)

11. To change whether the user can own or be assigned items, click the **Miscellaneous** tab and update those fields, as shown here.

![Figure 220: Changing user's item permissions](image)

12. Click the **OK** button. The user’s information is updated immediately, and the user sees the changes the next time he or she logs in.

### Deleting User Accounts

To delete a user’s account is to remove the user’s information from TaskMerlin altogether. If the user needs access in the future, an administrator must create a new account for the user. For this reason, if you must limit a user’s access only temporarily, it is better to disable the user’s account or reset the login status to No Login. See p. 155 for instructions.

When you delete a user, any items the user has created are removed, and any items assigned to the user now have no one assigned to them.

Before you can delete a user’s account, you must disable the account. The following procedure explains how to disable and then delete a user’s account.
To delete a user's account, take these steps:

1. Click the Manage menu, and click All User Profiles. The Manage User Profiles window opens, as shown here.

![Figure 221: Manage User Profiles window](image)

2. Find the user in the list. To narrow the list, click the Filter list, and choose one of the following:
   - Select Regular, enabled users to see only users whose login status is enabled.
   - Select Regular users to see all users regardless of login status.
   - Select Predefined users to see only the default users, such as Administrator.
   - Select All Users to see both predefined and added users.

3. If the user's account status is Enabled, select the user, and click the Edit button. If not, go to step 6.

4. In the Edit User Profile window, clear the Enabled check box to disable the user. This image shows how.

![Figure 222: Disabling the user's account](image)
5. Click the **OK** button to return to the list of users.
6. Select the user in the list, and click the **Delete** button.
7. In the Confirm User Delete window that opens, click **OK**.
8. In the Deletion Successful window that opens, click **OK**.

   The user account is removed and the user’s information no longer appears in the Manage User Profiles list.

### Managing Permission Templates (Professional Edition Only)

Permission templates are sets of permissions that you can assign to multiple users without having to change the permissions at the user account level. Using permission templates, you can group users into roles and manage their activities by limiting the roles’ options. For example, if you have users who manage projects, you can assign them to the Project Manager permission template, which has certain rights by default. For users who simply work on tasks, you can apply the permission template Team Member, which has fewer permissions than the Project Manager template.

The TaskMerlin Personal and Professional Editions include four default permission templates. In the Personal Edition, you can assign these template to users, but in the Professional Edition, you can customize these or add your own templates.

This section includes the following topics:

- "About the Default Permission Templates," this page
- "Template vs. User Level Permissions" on p. 161
- "Customizing Existing Permission Templates" on p. 161
- "Managing Permission Templates (Professional Edition Only)" on p. 160
- "Deleting Permission Templates" on p. 168

---

**About the Default Permission Templates**

TaskMerlin includes three permission templates. This table summarizes their differences.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Project Manager</th>
<th>Team Lead</th>
<th>Team Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access any item folder</td>
<td>X</td>
<td>X (Desktop Folders only)</td>
<td>X (All folders but Archive and Bin)</td>
</tr>
<tr>
<td>Edit any item field</td>
<td>X</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td>Columns visible in Item Grid</td>
<td>Default columns</td>
<td>Default columns</td>
<td>Default column, plus the column Assigned To</td>
</tr>
<tr>
<td>Permanently delete items</td>
<td>X</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Change item color</td>
<td>X</td>
<td>X</td>
<td>--</td>
</tr>
</tbody>
</table>
A fourth permission template, All, provides a way to assign permissions to all other permission templates at once. In other words, making a change to the All template cascades that change to all other templates automatically. The procedure for changing template properties explains how this works. See p 161.

Permission templates provide a way to assign the same permissions to many users without having to update each user account. However, if you make a change to a user account that contradicts the permissions in the permission template, the user's account setting overrides the permission template, but for that user only.

For example, if you create a user and assign the permission template of Team Lead to his account, but then you change the user's Login status to Administrator, the user now has administrator rights, which exceed the rights on the Team Lead template.

Similarly, if you create a user, assign her to the permission template of Project Manager, but disable the user's ability to assign items to other users, the setting on the user account overrides the permission to assign items to users on the Project Manager template, for that user account only.

You can change the settings on the existing permissions templates, including the global template of All. When you customize a template, you can do the following:

- Change which folders users with this template can see and work with.
- Pick which values in which columns users can see in the Item Grid.
- Limit which fields users can edit.
- Allow users to delete items.
- Allow users to edit public filters.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Project Manager</th>
<th>Team Lead</th>
<th>Team Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change item occurrence</td>
<td>X</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td>Edit public filters</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Choose any Owned By user</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Choose any Assigned To user</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Manage Item types</td>
<td>X</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td>Manage Status types</td>
<td>X</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td>Manage Context types</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Manage Priority types</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Manage Impact types</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
• Determine which users these users can assign items to, if any.
• Allow users to create, edit or delete custom item or attribute types.

This section explains how.

To customize an existing permissions template, take these steps:

1. Click the Manage menu, and click All User Profiles.
   The Manage User Profiles window opens, as shown here.

2. Click the Manage Permission Templates button.
   The Manage User Permission Templates window opens. All templates are listed in the Permission Templates list.
3. Click the template you want to customize. For example, click **Project Manager**. The Folder View tab to the right shows the Folder permissions for this template, as shown here. These permissions determine what folders users under this template can see if the Folders list.

![Folder View list](image)

*Figure 225: Folder View list*

4. To disable or enable folders, click the check box for each.

**Tip** To select or clear all children folders at once, click the Check Children or the Un-check Children buttons at the top.

5. To save your changes, click the **Apply** button.

6. Click the **Item View** tab.

   The Item View fields open.

![Item View](image)

*Figure 226: Item View tab*

You can use Item View to determine which values users see for which columns in the Item Grid by default. For example, here you can make sure
that users see only items with the status of In Progress in their Item Grid. Or you can make sure they see only items assigned to them in the Item Grid.

7. To determine which columns users see, do the following:
   - Click the add row button.
   - In the list under column, choose the attribute.
   - In the Function column, choose a value, such as Is, Is Not, Is One Of, or Is Not One Of. Use these values to include or exclude values you select in the next column.
   - In the Value column, choose the value. For certain attributes, the options here are True and False. For others, you can select and add several values to the list.
   - Repeat these steps to add more values.

This image shows how to enter this information. Here users under this template see only items assigned to them, with a status of Not Started, but they cannot see items with a priority of Low.

**Note** If any item is to appear in the user’s Item Grid under these parameters, the item’s attributes must be set. For example, an item without a Status does not appear in the user’s list, even if the user sees the Status column in the Item Grid.
8. Click the **Apply** button to save your changes.
9. Click the **Item Edit** tab.

The Item Edit fields open. The default for some templates is Edit any item field, which means these users can change the values in any field in an item. Here you can limit which fields users can edit, as this image shows.

![Figure 228: Item Edit tab](image)

10. Do the following:
   - To allow users to edit any item field, make sure the Edit any item field check box is checked.
   - To limit the fields, remove the check mark from the Edit any item field and select the item fields in the list that opens.

   **Tip** To select all fields at once, click the Check fields button. To clear all fields at once, click the Un-check fields button.

This image shows some fields selected for editing. In this example, users with this permission template can edit only the fields selected.

![Users can edit any fields selected here.](image)
In this list, users under this template can edit only the basic fields, such as Status, Progress, and Context.

11. Click the **Apply** button to save your changes.

12. Click the **Other** tab.

The fields that appear help you restrict access to item and attribute types, among other things, as this image shows.

13. In the Items list, indicate whether these users can permanently delete items or change their colors or recurrence properties.

14. In the Filters field, check or clear the **Edit public filters** check box. A check mark here means that these users can create, change, or delete the filters all users see.

15. In the Users fields, do the following:
   - To limit which Owned By users these users can select, click the **Limit selectable Owned By users** check box, and select users in the list that opens.
   - To limit which Assigned To users these users can select, click the **Limit selectable Assigned To users**, and select users in the list that opens.
16. In the Custom Types list, select which item and attribute types these users can modify. If they can modify these types, they can add them, create shortcuts for them, or delete them, too.

This image shows some options for the Other tab. In this example, users under this template cannot delete items, and they can choose only certain Owned By and Assigned To users, but they are not restricted in other ways.

![Miscellaneous options for users](image)

17. Click the **OK** button. Your changes are applied to all users under this template as soon as they log in again.

To create a permission template is to add a set of permissions users can share. It helps you refine users’ permissions. Only users with Administrator privileges can create permissions templates.

To create a permission template, take these steps:

1. Click the **Manage** menu, and click **All User Profiles**.

   The Manage User Profiles window opens, as shown here.

![Manage User Profiles window](image)

2. Click **Manage Permission Templates**.

   The Manage User Permission Templates window opens.
3. Click the **New** button, as shown here.

   ![Figure 233: Creating a template]

   A new, unnamed template appears in the list.

4. Type the name for the template in the list, as shown here.

   ![Figure 234: New Template in Template list]

5. In the Folder View, Item View, Item Edit, and Other tabs, create the permissions for this template.

   For instructions, see "Customizing Existing Permission Templates" on p. 161.

6. To save your changes and add another template, click the **Apply** button, and go back to step 3.

   To save your changes and close the window, click **OK**. The Manage User Profiles window reappears. Here you can assign users to the new template.

7. Click **Close** to close the Manage User Profiles window.

---

**Deleting Permission Templates**

When you delete a permission template, you prevent any users from being assigned to that template in the future. Any users already assigned to the template...
have their login set to None, so you must assign them to a new template before they can log in again.

To delete a permission template, take these steps:

1. Click the Manage menu, and click All User Profiles.

   The Manage User Profiles window opens, as shown here.

   Figure 235: Manage User Profiles window

2. To see which users have the template you want to delete, click the Filter list and choose All Users, as shown here.

   Figure 236: Filtering list of users by Login type

   The Login Type column in the list of users shows each one's template assignment.

3. To change a user's template now, click the user, click Edit, click the Login Type tab, and change the user's template there.

   Otherwise, go to the next step.

4. Click the Manage Permission Templates button.

   The Manage User Permission Templates window opens.
5. Click the template in the list, and click the **Delete** button, as shown here.

![Select the template, and click Delete.](Image)

6. In the confirmation window that opens, click **OK**.
7. Click **OK** to close the Manage User Permission Template window.
8. Click **Close** to close the Manage User Profiles window.

**Setting Up Users’ E-mail Options**

You can set up TaskMerlin so that users can e-mail items and documents to other TaskMerlin users (even if those users cannot login to TaskMerlin). Setting up e-mail for users involves these steps:

- Set up E-mail in the database options (explained next), which means setting preferences that apply to all TaskMerlin e-mail.
- Set up users and include their e-mail addresses in their profiles (see "Adding Users" on p. 149).
- Configure each user’s account with the e-mail server’s information (explained starting on p. 173).

Before any users can e-mail items, the TaskMerlin database must include e-mail information. The procedure in this section explains how to set up e-mail at the database level.
To set e-mail options for the database, take these steps:

1. Click the Tools menu, and click Options.
   The Options window opens.

   ![Options window](image)

   **Figure 238: Options window**

2. Click the Database list, and click E-mail.
   The E-mail tabs open, as shown here.

   ![E-mail settings in Database list](image)

   **Figure 239: Database e-mail options**

3. In the Subject field of the template tab, make any changes to the text that appears here.
   The default subject for any e-mail is: TaskMerlin [##[Item]: [Summary]], where [##[Item]] becomes the Item number, and [Summary] becomes the item's summary text--for example, TaskMerlin #75: Complete Time Card. Brackets around text indicate a field that TaskMerlin inserts automatically. You can change these fields by typing a new field name within the brackets or adding a field name surrounded by brackets.
4. In the Message field, type any message for any e-mail sent, such as “You have a new task,” and change the fields in the Message box as needed.

5. Click the **Attachments** tab.

   The Attachments fields open, as shown here.

![Figure 240: E-mail attachments settings](image)

Here you can determine whether items are attached as separate documents, and you can determine the format.

6. To include items as attachments in e-mail, do the following:
   
   a. Click the **Attach item when sending e-mail** check box.

   Users can override this option for individual e-mails.

   g. To include only the summary and content information in the attachments, click **Include Summary and Content fields only**.

   h. In Attached item format, click either **Rich text format (RTF)** or **Plain Text (TXT)**.

   RTF preserves the item’s formatting and can be read in Word. Plain text files have no formatting and are read in Notepad.
9. Click the **Options** tab.

The Options fields open. Here you can determine what changes to an item trigger an e-mail to the user.

![Set the e-mail options here.](image)

*Figure 241: E-mail Options fields*

10. In the E-mail the user when list, click the check boxes to determine who receives an e-mail and when.

   For example, to send a user an e-mail when she’s assigned an item, click **An item is assigned to them**.

11. Click **OK**.

---

**Setting Up Users' E-mail**

Once the TaskMerlin database is configured for e-mail (see the previous section), you can add information for each user.

Before you begin, make sure you have the following:

- Outgoing mail server name
- Type of secure connection if there is one (TLS, SSL)
- User's E-mail account name and password

To set up yours or another user's e-mail account, take these steps:

1. Make sure the user's profile includes the e-mail address.
   
   See "Adding Users" on p. 149 for instructions.

2. Click the **Manage** menu, and click **All User Profiles**.
   
   The Manage User Profiles window opens.
3. Click the user in the list, and click the **Options** button, as shown here.

![Select a user and click Options](image1.png)

*Figure 242: Select a user and click Options*

The Options window opens.

![User Options window](image2.png)

*Figure 243: User Options window*

4. In the TaskMerlin User list, click **E-mail**.

The E-mail fields open.
5. In the Connection fields, do the following:
   - In the Outgoing mail server list, select an outgoing server.
   - In the SMTP port list, choose the port.
   - In Use secure connect, leave No checked if there is none, or click TLS or SSL.
   - To test the connection, click Send test e-mail.
   This image shows how to complete these fields.

![Figure 244: E-mail settings for the user](image)

6. In the Authentication fields, enter the user’s account name and password if the outgoing mail server requires them, as shown here.

![Figure 245: User E-mail Authentication fields](image)
7. To allow the user to be cc'd on every e-mail she or he sends, click **Options**, and click **CC me when I send e-mails**.

   This image shows these fields.

![Image of User E-mail Options tab](image)

   **Figure 246: User E-mail Options tab**

8. Click **OK** to save your changes.

9. Repeat this procedure to set up other users.

   These changes apply to the user the next time she logs in.

---

**A Project Manager’s Guide to Managing Users and Permissions**

In “Navigating the TaskMerlin Workspace” you set up the sample project “Corporate Web Site” (p. 95). Now you can add TaskMerlin users who can create and update their tasks, and you can manage their permissions.

- Study the existing permission templates, and add new ones if you need them.
  
  For example, you might add a template called “Stakeholder” that lets a user see everyone’s tasks and activities (to check the status) but not edit them. See "About the Default Permission Templates" on p. 160, "Customizing Existing Permission Templates" on p. 161, and "Creating Permission Templates" on p. 167.

- Add your users. Your users are probably the same people you created People items for: The Web Designer, Content Writer, QA Tester, and Stakeholder. (Since you are the site Administrator and the Project Manager, you would not set up yourself as a user again.)

  See "Adding Users" on p. 149 for details.

- Set up e-mail options for the database, and then set up the users with e-mail.

  See "Setting Up Users’ E-mail Options" on p. 170.

- Start assigning tasks to users. Depending on their permissions, these users can own tasks or simply be the assignee for them.
CHAPTER 10: MANAGING YOUR DATABASES

This chapter includes the following topics:

- "About Databases," this page
- "The Default Database," this page
- "Creating a Database," this page
- "Navigating Between Databases" on p. 180
- "Customizing Databases" on p. 181
- "Exporting and Importing Database Settings" on p. 184
- "Backing Up the Database" on p. 188
- "Compacting the Database" on p. 189
- "A Project Manager's Guide to Managing Databases" on p. 190

About Databases

The database is what you see in the TaskMerlin workspace. It contains the items, filters, calendar, and any other things you can manage in the workspace. It includes users, permission templates, types, and attributes. In short, if you can see it in the workspace, it is part of the database.

Think of a database as a collection of items and settings with something in common. A database might contain items related to your work projects, while another one contains items related to your home life, such as bills and family members’ schedules.

The TaskMerlin workspace shows one database at a time. However, you can open and navigate more than one database at a time, and you can change the properties of any database in many ways.

The Default Database

The first database that opens when you install TaskMerlin is the My Tasks database (MyTasks.tmdb). It includes samples to use as you learn about TaskMerlin. You can add items and settings to MyTasks to make it your own, or you can create a blank database for your own use. That's covered in the next section.

The rest of this chapter explains how create, customize, and protect your databases in TaskMerlin.

Creating a Database

To create a database is to create a TaskMerlin workspace of your own. You can create a database with TaskMerlin’s default sample items, or you can create an entirely blank database.

You can also create a database by copying an existing database. The settings and items from the first database then appear in the new one.

This section explains how to create new databases or create them from other databases.
Creating a Blank Database

You can create a database with only the default folders, or one with sample items TaskMerlin includes by default. This procedure explains how to do both.

To create a database, take these steps:

1. Do one of the following:
   - To create a database with examples, click the File menu, click New Database, and click Database with Examples.
   - To create an empty, or blank, database, click the File menu, click New Database, and click Blank Database.

   This image shows how.

2. In the Save As window that opens, navigate to the folder that stores your database.

3. Type a name for the database.
   The default name is MyTasks.

   This image shows how.
4. Click **Save**.
    
The TaskMerlin workspace opens showing the database settings.
    
    You can begin adding items and creating settings. See the rest of this chapter for these options.

When you create a database from an existing database, the new database contains everything in the first database, but these databases become independent of each other. In other words, changes to make in the first database do not affect the second one after you create it.

To create a database from an existing database, take these steps:

1. Open the database you want to use for the new database.
2. In the File menu, click **Save As**.

    The Save Database As window opens, as shown here.

    ![Figure 249: Saving a database from an existing database](image)

3. In the Save in list, navigate to a location for this database.
4. In the File name field, type the new database's name.
5. Click **Save**.

    The new database is saved.
6. To open the new database now, click the **File** menu, click **Recent Databases**, and click the database name.

**Navigating Between Databases**

You can open and move between several databases at once. Navigating between databases includes:

- Opening a database with one already open
- Switching between open databases

When you navigate between databases, neither database closes unless you close it yourself.
To navigate between databases, do the following:

- To open a database you’ve recently used, click the File menu, click Recent Databases, and click the database from the list that opens, as shown here.

![Navigating between databases](image)

*Figure 250: Navigating between databases*

The database opens in a new workspace.

- To open a database you haven’t used recently, click the File menu, click Change Database, and find the database in the Change Database window that opens.

- To open a database, click the File menu, click Open, and find the database in the Open Database window that appears.

- To switch between open databases, click the TaskMerlin icon in the system tray, and select the database from the list that opens.

### Customizing Databases

To customize a database is to do the following:

- See the database’s existing properties.
- Change the description of the database.

TaskMerlin stores summary information about each database that you can view in the workspace. The summary information provided includes:

- The database’s location on your system or network (the path)
- Connection properties
- Configuration properties
- Number of items, folders, and filters in this database
- User login information
To see the database’s properties, take these steps:

1. Click the **File** menu, and click **Database Properties**.
   
   A window showing information about the database opens.

![Database Properties window](image)

*Figure 251: Database Properties window*

2. When you finish reading the information, click the **Close** button.

**Adding a Descriptive Name and Setting Database Properties**

You can add a description to the database. The description then appears in the title bar of the workspace, but it does not rename the TaskMerlin database file itself.

For example, if the file name of your database is MyTasks.tmdb, but you also add a name here, the file name does not change, but the new name appears in title bar of the workspace.

You can also change how often the database refreshes across the network or if files are locked over the Web when in use.

To set these database properties, take these steps:

1. Click the **Tools** menu, and click **Options**.
   
   The Options window opens.
Managing Your Databases

2. Find Database in the list, and click the plus sign to open it. This image shows how.

![Figure 252: Adding a descriptive name to the database](image)

3. In the list that opens, click General. The General fields open, as shown here.

![Figure 253: General fields of Database Options](image)

4. In the Description field, type a brief description. For example, you might enter the description for your MyTasks database of “Joe’s Tasks.”

5. (TaskMerlin network users only) In the Network database sharing section, do the following:
   - To make sure the database updates the workspace periodically, click the **Autorefresh** check box, and type a time interval, such as 15, in its field.
   - To lock files across the Web, click the **Web Locking** check box.
6. Click **OK**.

   If you changed the description, the description appears in the title bar, as shown here.

![Database name in Title bar]

**Exporting and Importing Database Settings**

You can copy another database’s column settings, custom types, and user options to your database.

- To import column settings is to import the columns and their order as they appear in the first database’s Item Grid.
- To import custom types is to import all types a user has added to the database. This includes custom Item, Status, Context, Priority, and Impact types, plus any other types created in the first database.
- To import user options is to import any settings the user has configured. (To see which options these are, click **Tools**, click **Options**, and look at the options in the TaskMerlin User section of the Options window.)

You can import some or all of these options. First, however, you must export the same settings from the first database. The following sections explain both exporting and importing settings from one database to another.

**Exporting Database Settings**

When you export a database’s settings, you save the settings in a .tms file. This section explains how to create and save the file. The next section explains how to open the file to import the settings to another database.

**To export database settings, take these steps:**

1. Open the database with the settings you want to copy (export).
2. Click the **File** menu, and click **Import and Export**. The Import/Export window opens.

![Import/Export window](image1.png)

*Figure 255: Import/Export window*

3. Click **Export Settings**. This image shows how.

![Export Settings option](image2.png)

*Figure 256: Export Settings option*
4. Click **OK**.

   The Export Settings window opens, as shown here.

   ![Export Settings window](image)

   *Figure 257: Export Settings window*

5. Make sure the options you want to copy are selected, such as Columns, and click **Export**.

   The Save As window opens

6. In the Save As window, do the following:
   a. In the Save in list, find a location for the .tms file.
   b. In the File name field, type a name for the file.
   c. Click **Save**.

9. In the Settings Have Been Exported Successfully window that opens, click **OK**.

   Your settings are saved and are ready to be imported into a different database.

   See the next section for instructions on importing settings.

---

**Importing Database Settings**

Before you can import settings, you must export those settings from another database to a .tms file. For instructions, see "Exporting Database Settings" on p. 184.

To import settings to a database, take these steps:

1. Click the **File** menu, and click **Import and Export**
2. In the Import/Export window that opens, click **Import Settings**, and click **OK**, as shown here.

![Import/Export window](image)

Figure 258: Import/Export window

3. In the Import Settings window that opens, select the options to import, and click the **Import** button.

This image shows how.

![Import Settings](image)

Figure 259: Import Settings

---

**Note** Remember that you cannot import a setting, such as Columns, if you did not export the same setting from the other database.
4. In the Open window that appears, use the Open list to find the file, select the file, and click **Open**, as shown here.

![Figure 260: Opening the Exported Settings file](image)

5. In the Import Settings confirmation window that opens, click **OK**. The settings are imported and your workspace includes the changes.

### Backing Up the Database

You can preserve a copy of the database by backing it up periodically.

To back up the database, take these steps:

1. Click the **Tools** menu, and click **Backup Database**.

   This image shows how.

![Figure 261: Backup Database menu item](image)
2. In the confirmation window that opens, click **OK**. The Backup Database As window opens.

![Backup Database As window](image)

*Figure 262: Backup Database As window*

3. In the Save in list, navigate to the location for the backup.

4. In the File name field, type a meaningful name for the backup file. For example, use the database's name and add the date, such as MyTasks_July132011.

5. Click the **Save** button.

   The Backup Database confirmation window opens. This window shows the name and location of the backed-up file.

![Backup Database confirmation window](image)

*Figure 263: Backup Database confirmation window*

6. Click **OK**.

   TaskMerlin restarts and the working database opens again.

### Compacting the Database

Compacting the databases compresses database files so that TaskMerlin runs more efficiently. This section explains how to compact your database.

When you compact the database, TaskMerlin restarts as part of the process. Make sure no other users are logged in to the database before you compact it.
To compact the database, take these steps:

1. In the database you want to compact, click the Tools menu, and click Compact Database.

   This image shows how.

   ![Figure 264: Compact Database menu item](image)

2. In the Compact Database window that opens, click OK.

   ![Figure 265: Compact Database confirmation window](image)

3. In the confirmation window that opens, click OK. TaskMerlin restarts.

A Project Manager’s Guide to Managing Databases

Here are some suggestions for protecting your project database and keeping it running efficiently.

- Back up the database periodically to capture and store the information in it at that time.
- To keep the database running efficiently, compact the database frequently, especially if you are working across a network or the Web.
- If you have archived a lot of items, export the archived items to a spreadsheet or to a new TaskMerlin database as a way to store the items without keeping them in your working files.